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1Getting Started
Welcome to mySewnet™ Draw & Paint, the software that helps you create wonderful 
drawings for embroideries, quilting and cutter designs, and pictures for backgrounds, 
PhotoStitch embroideries, and ExpressDesigns. Work with clipart images or create your 
own designs using a background picture in the Paint window.

Finding Information

Reference Guide
The Reference Guide shows how to start the software and provides a quick tour of the 
main screen. This is followed by information on key features, together with short ’How-To’ 
examples, which will help you learn how to use the your software. The Reference Guide 
additionally contains full reference information. The Reference Guide is supplied in PDF 
format , ready for printing.

To view and print the PDF Guides, you will need a PDF reader such as Windows® Reader (included in 
Windows® 10) or Adobe® Reader (available from adobe.com).

Tooltips and Online Help
To learn the name of a function, position the arrow pointer over its icon. A tooltip with the 
function name will appear.

The online help contains the ’How-To’ examples and full reference information. Use the 
Help icon , press F1 or click the Help button. Where available, a help topic will appear 
that is relevant to the item where help was requested.
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Where to Start
Starting mySewnet™ Draw & Paint

Windows® 10 Start Screen
1 At the bottom left of your computer screen, open the Windows® 10 Start menu.
2 In the Windows Start menu, scroll down to the mySewnet folder.
3 In this section, click on mySewnet™ Draw & Paint  to launch it.

Shortcuts
An alternative to the Start screen/menu method described previously is to use a Shortcut 
to mySewnet™ Draw & Paint. This is created automatically during the installation process.

Windows® 10 (Start Screen)
1 Click on the mySewnet™ Draw & Paint  tile in the Start Screen.

Windows® 10 (Desktop)
1 Close or minimize any programs you have running.
2 Double-click on the Shortcut to the mySewnet™ Embroidery Software folder. A list of the programs 

appears.
3 Double-click on mySewnet™ Draw & Paint  to launch it.

Closing mySewnet™ Draw & Paint

Exit
Ends the mySewnet™ Draw & Paint session. You can also use the Exit command on the 
mySewnet™ Draw & Paint Control menu.

Shortcuts

■ Mouse: Click the Close icon  on the title bar or double-click the Control menu box.
■ Keys: Alt + F4

About mySewnet™ Draw & Paint
Access via the Help tab. The version number of mySewnet™ Draw & Paint is given here. You 
will need this if you contact technical support at any time.

Shortcut
■ Keys: Alt, H, A
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Parts of the Software Window
Title Bar
The title bar at the top of the window is highlighted if 
mySewnet™ Draw & Paint is active. The Quick Access toolbar 
gives icons for the following frequently used features: Insert, Save, Save As, Undo, Redo. 

If more than one instance of mySewnet™ Draw & Paint is open, each open window will 
show the name of the drawing file.

Ribbon Bar
There are 7 tabs on the ribbon: File, Draw, Paint, Insert, Multiply, View and Help.

An alternative way to access ribbon options is to press the Alt key, then the highlighted letter of the tab, 
followed by the highlighted letter of the tab item, e.g. Alt, D, CC to Copy the selected object. Some functions 
are available by pressing the Ctrl key and another key at the same time. These shortcuts are shown in the 
tooltip for the relevant function.
Use the Draw tab to select, copy and Group parts of a drawing; and to create holes in filled 
shapes.

Use the Paint tab to select, copy and delete parts of a bitmap (raster) picture.

Use the Insert tab to add Shapes, Lettering and Designs to your drawing.

Use the Multiply tab to repeat drawings or actions automatically by reflecting across and/
or down, and by rotating. 

Use the View tab to adjust the Grid, measure the design, and show and fade the 
background picture.

Select part or all of the drawing Group or Ungroup the selected objects

Make and Uncombine Holes

Cut, copy, paste or delete the selected objects

Snap to Grid or Line

Send the selected object(s) to the Paint tab

Create Motifs

Cut, copy, paste or delete an area of the picture

Use a selection tool to choose part or all of the picture
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Draw Window

Use the Draw window to load or create a vector drawing for your design. Modify a drawing 
as desired, or make your own drawing. Load a raster image to use as a background in the 
Paint window. The Draw window contains a FilmStrip to the left and design panel to the 
right of the Canvas, in addition to the ribbon tab. 

The Draw tab has tools for copying, selecting, combining and grouping objects.

FilmStrip
To the left of the Canvas is the FilmStrip. The FilmStrip displays the objects such as the 
lines, fills and groups in the drawing, and enables you to move objects within the drawing.

Use the FilmStrip to view the numbered sequence of objects, select objects, change the 
sequence of objects, and delete objects.

Design Panel
To the right of the Canvas is the design panel. At the top are the line and fill colors, each 
giving access to a color palette of 40 common colors, and the Colors dialog which enables 
you to use many more colors. 

The middle section has tools for drawing and editing pictures. The tool options change 
according to the drawing tool being used.

Quick Access Toolbar Ribbon Bar Tabs Ribbon Bar Title Bar

Canvas

Draw Panel

FilmStrip Status Bar
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Paint Window

Use the Paint window to load, scan or create a picture or background for your design. Load 
pictures or photos, modify pictures as desired, or draw your own picture. The Paint 
window contains a control panel to the right of the work area, as well as the ribbon tab.

In the Paint tab, select part of your picture with one of the range of selection tools, and 
Copy, Cut or Duplicate the selected area.

Control Panel
To the right of the Paint window work area is the control panel. Choose a design mode, 
and add to your picture with paintbrush, pen and fill tools. Select colors in the color box 
with a color palette of 40 common colors, or choose a wider range form the Colors dialog. 
Use Effects to alter all or part of the picture.

Title Bar
The title bar at the top of the window is highlighted if mySewnet™ Draw & Paint is active. 
The title bar shows the program name and the name of the currently loaded drawing.

Canvas
The Canvas is the area where the picture is displayed and edited, and the design is created 
and edited.

Status Bar
The status bar is found at the bottom of each window. Starting from the left, the status bar 
shows:

• The zoom tools.
• The Zoom Bar.

Quick Access Toolbar Ribbon Bar Tabs Ribbon Bar Title Bar

Canvas

Paint Panel

Status Bar
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mySewnet™ Draw & Paint Terms and Conventions
On-screen Pointers
The pointer is most commonly shown as an arrow  on the screen.

If it is positioned over a text box it changes to an I-bar  and you can type, such as the 
Edit Notes dialog box in the Design Panel.

If Zoom To Rectangle  is chosen, the Zoom In pointer  appears. If the Pan feature is 
used to move around the screen, the Pan cursor  appears. If Get Length  is chosen the 
Measure pointer  appears.

If the Freehand functions are used the pointer becomes a pen . 

If the Point Line functions are chosen the pointer becomes a circle , and when lines are 
drawn with Bezier Draw , the pointer becomes a Bezier Draw pointer . When points 
are converted to Curve the pointer becomes the Convert Points to Curve pointer , and 
when points are converted to Corner points the pointer becomes the Convert Points to 
Corner pointer .

When points on Point Lines or Bezier Lines are adjusted the pointer becomes a small 
cross  (a Move pointer).

When the Pick Line Color  or Pick Fill Color  functions are selected, the eyedropper 
pointer  appears.

The Box Select pointer , Freehand Select pointer  or Point Line Select pointer  
appear when the associated Select function is chosen. 

There are several pointers indicating functions in the selection box. The Rotate pointer  
appears when the mouse pointer is over the Rotate handle . The cross-hair pointer  
appears when the mouse is over the center of rotation .

The diagonal double-headed arrow  pointer appears when the mouse pointer is over a 
square corner handle . The horizontal double-headed arrow  pointer appears when 
the mouse pointer is over the Flip Horizontal handle . The vertical double-headed 
arrow  pointer appears when the mouse pointer is over the Flip Vertical handle . The 
horizontal and vertical double-headed arrows also appear when the Skew handles  are 
used. The pointer becomes a four-headed arrow  (a move pointer) when it is over a 
selection box.
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Touch Gestures
Touch gestures are used when viewing and moving drawings in mySewnet™ Draw & Paint. 
They are available when using a touch-sensitive screen. 

General

Select and move
One finger touch and one finger slide are equivalent to click and drag with a mouse. Use 
to move embroideries, select, draw or create stitches with freehand features, and so on.

Autoscroll
When you drag within a document, the autoscroll feature moves the pointer 
automatically, changing the view of the Canvas. 

This is useful when zoomed in. Use autoscroll while moving or resizing a selected 
embroidery.

■ Use a two finger swipe on the Canvas.

Pinch to zoom
Pinch two fingers to zoom in, and spread two fingers to zoom out.

Context menu
Press and hold and a context-sensitive menu will appear if available (similar to a right-
click). 

Picture File Formats
mySewnet™ Draw & Paint can load vector files in the following formats: mySewnet™ Draw 
& Paint Files (.ecq), 4D / 5D QuiltDesign Creator 4QB (*.4qb) and Scalable Vector Graphics 
(.svg) formats. Windows Meta File (.wmf ), Windows Enhanced Meta File (.emf), CorelDraw 
(.cdr version 7-13, .cmx) and Encapsulated PostScript File (*.eps) files can also be loaded.

mySewnet™ Draw & Paint can load quilting files in the following formats: QuiltSewClever / 
Quilt Artist / Shirley Stitcher QCC (*.qcc), HPGL (*.hp and *.plt), PC Quilter (*.txt), Statler 
Stitcher (*.qli), AutoCAD (*.dxf ), CompuQuilter (*.cmd and *.cqp), Handi Quilter (*.hqf ) and 
IntelliQuilter (*.iqp).

mySewnet™ Draw & Paint can load the following bitmap file formats: Windows or OS2 
Bitmap (.bmp), JPEG-JFIF Compliant (.jpg, .jif, .jpeg), Portable Network Graphics (.png) and 
Tagged Image File Format uncompressed (.tiff, .tif ).

mySewnet™ Draw & Paint can save drawings in the mySewnet™ Draw & Paint (.ecq) 
drawing file format.

mySewnet™ Draw & Paint can Export a picture in any of the following picture file formats: 
Scalable Vector Graphics (.svg), JPEG Low Quality (.jpg), JPEG High Quality (.jpg) and 
Portable Network Graphics (.png).



8          mySewnet™ Draw & Paint   Managing Images 

2Managing Images
You may open drawings (vector graphics) and pictures (bitmap graphics) with Insert  
and Open , and open pictures with From Scanner or Camera .

You can only use Open  when there are no objects in the drawing. Either use Insert  instead, or click 
File, New Window and then open the drawing.

Insert
Use Insert  to add an existing drawing or painting to the current design. All sections of a 
vector graphic design will be grouped together, ready for moving, resizing and so on.

mySewnet™ Draw & Paint displays the Open dialog so you can choose an image to open. 
You may load quilting and vector graphic design files in a variety of formats, and bitmap 
files.

Open a folder, and scroll down and click a drawing to select it. Click OK to load the drawing 
on the Canvas.

File Name
Type or select the filename you want to open.

Files of Type
This is set to All Files (*.*).

Look In
Select the drive or folder containing the file that you want to open.

More Options
Switch from list  or details  view to icons with thumbnail images of the drawing. For 
example, Extra Large icons .

Preview Pane
Preview the drawing file before opening .

Click Open to load the 

Browse to a different folder

Click on an image to select it

Search for a picture

Change the view or icon size

selected image
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You can change the icon size, and show the names of the drawings.
You may load vector files in the following formats: mySewnet™ Draw & Paint Files (.ecq), 
4D / 5D QuiltDesign Creator 4QB (*.4qb) and Scalable Vector Graphics (.svg) formats. 
Windows Meta File (.wmf), Windows Enhanced Meta File (.emf ), CorelDraw (.cdr version 7-
13, .cmx) and Encapsulated PostScript File (*.eps) files can also be loaded.

You may load quilting files in the following formats: QuiltSewClever / Quilt Artist / Shirley 
Stitcher QCC (*.qcc), HPGL (*.hp and *.plt), PC Quilter (*.txt), Statler Stitcher (*.qli), 
AutoCAD (*.dxf ), CompuQuilter (*.cmd and *.cqp), Handi Quilter (*.hqf ) and IntelliQuilter 
(*.iqp).

The following bitmap file formats may be loaded: Windows or OS2 Bitmap (.bmp), JPEG-
JFIF Compliant (.jpg, .jif, .jpeg), Portable Network Graphics (.png) and Tagged Image File 
Format uncompressed (.tiff, .tif ).

Shortcut
■ Quick Access Toolbar and File Menu: 
■ Keys: Ctrl + I

Insert an Image
1 In the Quick Access toolbar, click Insert . The Open dialog box appears.

Alternatively, click File, Insert .
2 Browse through the drives and folders of the computer to the desired folder.
3 Click on an icon to select the image.
4 Click Open to load the image into the Canvas.

Alternatively, double-click the icon for the drawing.

Open
Use File, Open  to open an existing image. mySewnet™ Draw & Paint displays the Open 
dialog box so you can choose an image to open.

Open a folder, and scroll down and click a drawing to select it. Click OK to load the drawing 
on the Canvas.

File Name
Type or select the filename you want to open.

Click Open to load the 

Browse to a different folder

Click on an image to select it

Search for a picture

Change the view or icon size

selected image



10          mySewnet™ Draw & Paint   Managing Images 

Files of Type
This is set to All files.

Look In
Select the drive or folder containing the file that you want to open.

More Options
Switch from list  or details  view to icons with thumbnail images of the drawing. For 
example, Extra Large icons .

Preview Pane
Preview the drawing file before opening .

Shortcuts

■ File Menu: 
■ Keys: Ctrl + O

Open an Image
1 Click File, Open . The Open dialog appears. 
2 Browse through the drives and folders of the computer to the desired folder.
3 Click on an icon to select the drawing.
4 Click Open to load the drawing into the Canvas.

Alternatively, double-click the icon for the drawing.

From Scanner or Camera
Use From Scanner or Camera  to display the program that is used to acquire pictures 
from the selected scanner, digital camera or other suitable device. Only devices that use 
Windows Image Acquisition (WIA) can be used to obtain pictures.

WIA (Windows Image Acquisition) is a standard method for transferring pictures from the device’s 
scanning or downloading program to another program, in this case the mySewnet™ Draw & Paint module 
of the mySewnet™ Embroidery Software. If the manufacturer provides the appropriate software 
components needed for WIA compliance, these should have been installed when the device was installed.
Each scanner or digital camera has its own program that is used to scan or download 
pictures. Refer to the manual or online help provided with the program for instructions, if 
required. When the device and its software finish processing the picture, it will be shown 
in the work area.

mySewnet™ Draw & Paint displays pictures in High Color (16-bit), so some difference may be noticeable 
compared with the display in other picture viewing programs if your computer is set to True Color (24-bit or 
32-bit). This does not affect the quality of the embroideries produced.

Shortcut

■ File Menu: 
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Load a Design with Drag and Drop
To drag and drop a drawing or bitmap graphic file onto the screen, use Windows® 
Explorer.

Drag a Design to the Canvas
1 In Windows®, open an Explorer window. If required, resize the Explorer window so you can see both 

Explorer and mySewnet™ Draw & Paint.
2 Browse through the drives and folders of your computer to find the folder with your drawings in it.
3 Click on the desired design name or icon to highlight it.
4 Use the mouse to drag and drop the design onto the mySewnet™ Draw & Paint screen. The design will 

be displayed on the screen.
5 Close Explorer.

Recent
Open previously used image files via the file names in the Recent section of the File menu. 
Select the name of the desired design file.

Shortcut
■ File Menu: Recent

New
Use New  to clear the mySewnet™ Draw & Paint screen and create or load a new design. 
You are prompted to save the current design if changes have been made. 

Shortcuts
■ File Menu: 
■ Keys: Ctrl + N

New Window
Use File, New Window  to open an additional mySewnet™ Draw & Paint window so that 
you can start a new design. To move between open mySewnet™ Draw & Paint windows, 
hover over the mySewnet™ Draw & Paint icon on the taskbar, and select the desired 
window.

Shortcuts
■ File Menu: 
■ Keys: Ctrl + Shift + N

Save Designs
Save
Use Save  to save the design file under its current name and folder. When you save a 
design for the first time, mySewnet™ Draw & Paint displays the Save As dialog box so you 
can name the design file. To change the name and folder of an existing design file, use 
Save As.
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Shortcuts
■ Quick Access Toolbar; File Menu: 
■ Keys: Ctrl + S; Alt, 2

Save As
Use Save As  to save and name the design file. mySewnet™ Draw & Paint displays the 
Save As dialog box so you can name your design. To save a design with its existing file 
name and folder, use the Save command.

Shortcuts
■ Quick Access Toolbar; File Menu: 
■ Keys: Ctrl + Shift + S; Alt, 3

Export Picture
Use Export Picture  to export your picture in .SVG, .PNG or .JPG graphics format.

Use Save  or Save As  to save both the Draw and Paint parts of your picture in .ECQ format.

• When you export as .SVG the vector graphics from the Draw tab are saved.
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• When you export as .PNG, the raster graphics from the Paint tab, and the vector 
graphics from the Draw tab are saved as a single .PNG layer.

• When you export as .JPG, the raster graphics from the Paint tab, and the vector graphics 
from the Draw tab are saved as a .JPG file. Select the quality of the image from Low, 
Medium or High.

Shortcut

■ File Menu: 
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3Select, Modify & Copy

Selecting Areas and Objects
When one of the editing tools is being used, the currently active line or area is surrounded 
by a box. If that box is selected, the line or area can be moved, resized, mirrored, rotated 
and skewed. The selection tools can also be used to select and manipulate several 
individual objects at once, or several objects forming a Group.

You can select more than one object by holding down Ctrl and clicking the desired objects in the 
FilmStrip.See “FilmStrip” on page 58.You can also select a sequence of objects in the FilmStrip with Shift. 
See “Select Objects in the FilmStrip” on page 59. To change the selection of objects on the Canvas, use Add 

to Selection  and Remove from Selection . See “Add To Selection” on page 20 and “Remove From 
Selection” on page 20. 

Select a Block
The select functions allow you to select a block of lines or areas. A selected block can be 
resized, rotated, skewed, mirrored, moved, copied, cut and deleted.

When making a selection, only objects that are completely enclosed by the selection line will be included in 
the selection.
When a block has been selected, it has a 
selection box around it on the Canvas. 
The selection box has handles which are 
used to resize, rotate and mirror the 
block.
• Click and drag inside the block to 

move it, or use the arrow keys on the 
keyboard to nudge the block by small 
amounts.

• Click and drag the square corner 

handles  to resize the block. 
Hold down Shift as you click and drag to resize proportionally. Hold down Ctrl to resize 
from the center.

• Click and drag the round rotate handle  to rotate the block freely. 

• Click the triangular handles  to mirror the block horizontally or vertically.

• Click and drag the center of rotation  to rotate around a different point. 

• Click and drag on of the skew handles  to skew the block. 
• Right-click the block to change the properties of the lines and fills within it. The 

Changing the Colors for Lines and Fills dialog will appear.

See “Changing the Colors for Lines and Fills” on page 30.

Mirror Vertical Handle

Rotate
Handle

Resize
Handle

Skew
Handle

Mirror
Horizontal

Handle

Center of
Rotation



mySewnet™ Draw & Paint   Select, Modify & Copy              15

If the block is smaller than 1.5mm high or wide, the selection box will just be a plain rectangle with no 
handles.

Inserting or Pasting a Block
When a new selection is added to a design by paste or one of the insert functions, it is 
automatically selected as the current block and Object Select  (Draw only) or Box 
Select  is activated. 

Deselecting a Block
Click the drawing area outside a block to deselect it. The selection box around the block 
will disappear. Right-click to deselect a block and also turn off the current select function.

Object Select
Object Select is only available on the Draw tab.
With Object Select , click on the object (line or filled area) that you want to select. The 
selection box will show you the extent of the block. Click outside the block to deselect it. 
Object Select is also activated automatically when a block is pasted.

Object Select is enabled until another tool is activated.

Use Add to Selection  with any select function to increase the area of selected objects, or use Remove 

From Selection  to make the currently selected area smaller.

If the wrong area is selected, click in the active window, but outside the box, to deselect.

Shortcuts
■ Draw Tab, Select: 

Object Select Click to select an object. (Draw only)

Box Select Click and drag to draw a rectangle around the area you want to select. 

Freehand Select Click and drag to draw an irregular outline around the desired area.

Point Line Select Click a series of points to create an irregular outline of straight or 
curved lines around the desired area.

Ellipse Select Select an area of the picture by drawing a circle or ellipse around it.  
(Paint only)

Magic Want Select an area of similar color to where you clicked. (Paint only)

Select All Select all visible objects in the drawing with one click.

Select None  Deselect all of the objects in the drawing.

Invert Selection All the currently selected areas become deselected, and the 
deselected areas become selected. (Paint only)

Replace Selection Replace the currently selected area with the new selection.

Add to Selection  Add the new selection to the currently selected area.

Remove from Selection Remove the new selection from the currently selected area.
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■ Keys: Alt, D, O

Select an Object with Object Select
1 In the Draw tab, click the Object Select icon .
2 Click on the required object. It becomes the current selection, indicated by a rectangle with white 

handles.
3 If you want to make a new selection, click on a different object to select it.
4 Object Select is enabled until another tool is activated.

Box Select
With Box Select , click and drag to draw a rectangle around the area you want to select. 
Alternatively, click on a line or group to select it. The four-headed arrow Move pointer  
appears as you approach an object. Click and drag around the area you want to select. 
When you release the mouse button, the selection box will show you the extent of the 
block. Click outside the block to make a new selection using this method. Only objects 
that are completely enclosed by the selection line will be selected.

Box Select is enabled until another tool is activated.

Use Add to Selection  with any select function to increase the area of selected objects, or use Remove 

From Selection  to make the currently selected area smaller.

If the wrong area is selected, click in the active window, but outside the box, to deselect.

Shortcuts
■ Draw Tab, Select; Paint tab: Select: 
■ Keys: Alt, D, B; Alt, P, B

Select Objects with Box Select
1 Click the Box Select icon .
2 Click and drag to draw a rectangle around the required objects.
3 Lift the pen or release the mouse button when the required objects are enclosed. They will become 

the current selection, indicated by a rectangle with white handles.
4 If you want to make a new selection, click outside the current selection to deselect it. Then draw a 

new box around the required objects.
5 Box Select is enabled until another tool is activated.

Freehand Select
With Freehand Select , click and drag to draw an irregular outline around the desired 
area. Alternatively, click on a line or group to select it. The four-headed arrow Move 
pointer  appears as you approach an object. Click Freehand Select and the pointer 
changes to the freehand select pointer . Click and drag to draw an irregular outline 
around the desired area. When you release the mouse the area is closed automatically 
with a straight line between the last mouse position and the start position. The selection 
box will show you the extent of the block. Click outside the block to make a new selection 
using this method. Only objects that are completely enclosed by the selection line will be 
selected.

Freehand Select is enabled until another tool is activated. Right-click to deselect.
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Use Add to Selection  with any select function to increase the area of selected objects, or use Remove 

From Selection  to make the currently selected area smaller.

Freehand Select is useful when an area cannot be easily selected by using the simpler Box 
Select function. 

If the wrong area is selected, click in the active window, but outside the box, to deselect.

Shortcuts

■ Draw Tab, Select; Paint tab: Select: 
■ Keys: Alt, D, F; Alt, P, F

Select Objects with Freehand Select
1 Click the Freehand Select icon .
2 Click and drag to draw a line around the required objects. The objects inside the line will become the 

current selection, indicated by a rectangle with white handles.
3 The line is closed automatically in a straight line between your start point and end point. If you are 

not close enough to your start point then you could leave out some desired objects by accident.
4 If you want to make a new selection, click outside the current selection to deselect it. Then draw a 

new line around the required objects.
5 Freehand Select is enabled until another tool is activated, or you right-click to deselect.

Point Line Select
With Point Line Select , click a series of points to create an irregular outline of straight or 
curved lines around the desired area. Click Point Line Select and the pointer changes to 
the Point Select pointer . Click a series of points to create an irregular outline of 
straight or curved lines around the desired area, using Shift+click to place a square 
(straight line) point. Click and drag  to reposition an existing point. Click Delete to 
remove the last–placed point. Right-click when the area is complete. The selection box will 
show you the extent of the block. Point Line Select may be easier to use than Freehand 
Select for precise selections. Click to deselect. Only objects that are completely enclosed 
by the selection line will be selected.

Point Line Select is enabled until another tool is activated. Right-click to deselect.

Use Add to Selection  with any select function to increase the area of selected objects, or use Remove 

From Selection  to make the currently selected area smaller.

If the wrong area is selected, click in the active window, but outside the box, to deselect.

Shortcuts
■ Draw Tab, Select; Paint tab: Select: 
■ Keys: Alt, D, P; Alt, P, P

Select Objects with Point Line Select
1 Click Point Line Select . The pointer changes to the Point Line Select pointer .
2 Click to place the first point for the selection. A yellow square point appears.
3 Click to place a series of points around the desired area.

As you click the third point on the line, the line becomes closed (it becomes a loop). As you place more 
points the line adjusts itself.
The line may ’swing’ while you place points. Just carry on, you can adjust it afterwards.
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4 Use Shift+click to place square points for straight lines.
5 Move the pointer over one of the points on the line. The pointer changes to the Move Point 

pointer . Adjust the point as desired.
When the Move Point pointer is active you can adjust existing points.

If you click while the Point select pointer  is active, another point will be added to the line.
6 When your line is as desired, right-click to surround the area with a selection box.
7 Right-click to deselect Point Line Select.

Ellipse Select
Ellipse Select is only available on the Paint tab.
Use Ellipse Select  to select an area of the picture by drawing a circle or ellipse with a 
rectangular selection box around it. 

Click Ellipse Select and the pointer changes to the ellipse select pointer . Click and drag 
around the area that you want to select.

If the wrong area is selected, click in the active window, but outside the selected area, to deselect.
To resize, click and drag one of the corner resize handles as desired. Rotate the selection to 
any degree with the rotate handle. Click and drag inside the selection to move it to a new 
position in the picture.

Use Add to Selection  with any select function to increase the selected area, or use Remove From 

Selection  to make the currently selected area smaller.

After selection, move, delete, cut, copy, resize, rotate, or mirror the selection. Crop the 
picture so that only the selected area remains. Apply image effects to enhance or adjust 
only the selected area.

Ellipse Select is enabled until another tool is activated. Right-click to deselect.

Shortcuts
■ Paint Tab, Select: 
■ Keys: Alt, P, E

Select an Area with Ellipse Select
1 Click Ellipse Select .
2 Click and drag around the desired area of the picture. The selection will be shown by the dashed 

selection box.
3 If you want to make a new selection, click outside the current selection to deselect it. Then draw a 

new ellipse around the required area.
4 Ellipse Select is enabled until another tool is activated, or you right-click to deselect it.

Magic Wand
Magic Wand is only available on the Paint tab.
The Magic Wand  selects an area of similar color to where you clicked. The color, hue 
and brightness are used when making this selection. 

Click Magic Wand Select and the pointer changes to the magic wand pointer . 

If the wrong area is selected, click in the active window, but outside the selected area, to deselect.
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Use the Tolerance  settings on the Paint tab to set the color variation for the Magic 
Wand selection. Drag the slider, or change the numbers. See “Tolerance” on page 86.

The Magic Wand is enabled until another tool is activated. Right-click to deselect.

Use Add to Selection  with any select function to increase the selected area, or use Remove From 

Selection  to make the currently selected area smaller.

Shortcuts
■ Paint Tab, Select: 
■ Keys: Alt, P, M

Use Magic Wand Select
1 Click Magic Wand Select .
2 Change the color sensitivity of the Magic Wand with Tolerance , by moving the slider, or adjusting 

the numbers.
3 Click on a color within your picture. Adjacent areas in the picture with a similar color to the area that 

you clicked are selected.
The selection will be shown by a dashed line.

4 If you want to make a new selection, click outside the current selection to deselect it. Then make a 
new selection.

5 The Magic Wand is enabled until another tool is activated, or you right-click to deselect it.

Invert Selection
Invert Selection is only available on the Paint tab.
When Invert Selection  is clicked all the currently selected areas become deselected, 
and the deselected areas become selected. 

This is useful when you want to apply an effect to everything except a small area.

If the wrong area is selected, click in the active window, but outside the selected area, to deselect.

Shortcuts
■ Paint Tab, Select: 
■ Keys: Alt, P, SV

Exclude a Small Area when Selecting
1 Use one of the selection tools to select the area that you want to exclude from an effect.
2 Click Invert Selection .
3 The previously selected area becomes deselected, and the deselected area becomes selected.

Select All
Select All  is a one click function that selects all visible objects in the drawing, or the 
whole image. This is useful to resize or reshape the entire drawing.

Shortcuts
■ Draw Tab, Select; Paint Tab, Select: 
■ Keys: Ctrl + A; Alt, D, SA; Alt, P, SA
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Select None
Use Select None  to deselect all of the objects or selected areas in the image.

Shortcuts
■ Draw Tab, Select; Paint Tab, Select: 
■ Keys: Alt, D, SN; Alt, P, SN

Replace Selection
Use Replace Selection  to replace the currently selected area with the new selection.

Replace a Selection
1 Place an image on the Canvas.
2 Use Box Select  (or another selection tool) to select an area.
3 Ensure that Replace Selection  is selected.

Replace Selection is initially selected.
4 Using Box Select , select something else.

The new selection replaces your old selection.

Shortcuts
■ Draw Tab, Select; Paint Tab, Select: 
■ Keys: Alt, D, SR; Alt, P, SR

Add To Selection
Use Add to Selection  to add the new selection to the currently selected area.

Add an area to a Selection
1 Place an image on the Canvas.
2 Use Box Select  (or another selection tool) to select an area.
3 Click Add to Selection .
4 Using Box Select , select a different area.

The new selection is added to your old selection.

Shortcuts
■ Draw Tab, Select; Paint Tab, Select: 
■ Keys: Alt, D, SD; Alt, P, SD

Remove From Selection
Use Remove from Selection  to remove the new selection from the currently selected 
area.

Remove an area from a Selection
1 Place an image on the Canvas.
2 Use Box Select  (or another selection tool) to select some an area.
3 Click Remove From Selection .
4 Using Box Select , select an area within your selection.

The new selection is removed from your original selection.
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Shortcuts
■ Draw Tab, Select; Paint Tab, Select: 
■ Keys: Alt, D, SM; Alt, P, SM

Modify a Block
Move a Block
Move a selected block using click and drag, or nudge. Click on an area or object inside the 
block and drag it to the required position, or use the arrow keys to nudge it into place.

If Snap to Grid is enabled in the Draw window, the block of objects will snap to the grid when moved.

If you accidentally move the center of rotation , simply click and drag it inside the selection box again.

How to Move a Block
1 Click on an area or any of the objects inside the selection. The pointer becomes a four-headed 

arrow . Drag the selection to the required position. The rectangle around the selection will be 
dragged with the pointer.

2 Lift the pen or release the mouse button to drop the selection in place. The selected area will be 
redrawn in its new location.
Alternatively, use the arrow keys to nudge the selection into position, then click outside the block to place 
it.
When you move a selection, you may sometimes move the center of rotation by accident. Simply 
release the center of rotation, then click and drag the selection as usual. The center of rotation will 
snap back to the center of the selection when you drop the selection in its new position.

Resize a Block
Click and drag one of the square corner handles  to resize the block. The pointer 
becomes a double-headed arrow .

Hold down Shift as you click and drag to resize proportionally. Hold down Ctrl to resize from the center.

How to Resize a Block
1 If you want to keep the selected area in proportion, hold down the Shift key.
2 Click and drag any of the square  resize handles. The pointer becomes a double-headed 

arrow .
3 Lift the pen or release the mouse button, and then release the Shift key if you used that to keep the 

proportions. The selection will be redrawn at its new size.
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Skew a Block
Skew a block vertically or horizontally using the Skew handles  to the right of and 
below the Center of Rotation. Click and drag either handle to reshape the selection box, 
and the drawing.

How to Skew a Block
1 Mouse over the horizontal diamond shaped  skew handle. The 

pointer becomes a vertical double-headed arrow .
When the vertical skew handle is used, the pointer becomes a horizontal 
arrow .

2 Drag to skew the drawing.
3 Adjust the skew, then release the mouse button.

When you release the mouse button the selection box is redrawn as a 
square in the new position.

4 Click and drag again to make any further adjustments.
If you mirror a skewed object, this applies to the original shape before the 
skew was applied. To apply it after the skew, deselect and reselect the 
object.
Otherwise, if the skewed object was originally symmetrical only the mirror 
handle may appear to move.

Mirror a Block 
Mirror a block vertically or horizontally using the triangular mirror handles  on the 
block selection box. The pointer becomes a double-headed arrow .

If the area to be mirrored was originally symmetrical, and has been rotated or skewed, deselect and 
reselect before mirroring. This is because the mirroring effect is applied to a design before rotating or 
skewing.
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Horizontally Mirror Block
Click the Mirror Horizontal handle  to mirror a block horizontally. 

Vertically Mirror Block
Click the Mirror Vertical handle  to mirror a block vertically.

Rotate a Block
Click and drag the rotation handle  to rotate the block freely to any angle. The pointer 
becomes the rotate pointer . If desired, move the center of rotation  before rotating 
the block.

The selection box around the block is rotated around the center of rotation.

Move the Center of Rotation
The center of rotation  is initially shown in the middle of the block. Click on or within 
the center of rotation, then drag it to any position in the drawing. This changes the pivot 
point around which the block rotates.

If you mirror a rotated area, this applies to the original shape before the rotate was applied. To apply it 
after the rotate, deselect and reselect the object.
Otherwise, if the rotated area was originally symmetrical only the mirror handle may appear to move.

Delete
Use Delete  to delete a block after it has been selected using one of the block selection 
methods (for example, Box Select, Freehand Select, Point Line Select or Select All). 
Alternatively, use the Delete key.

This function differs from Cut because it does not place the objects on the Clipboard Block. Therefore 
objects that have been Deleted cannot be pasted into another drawing (although Undo can be used if the 
wrong area is deleted).

Deleting Single Points
Use Delete Points  to delete individual points in a drawing in the Draw window.

See “Delete Points” on page 47.

Shortcuts
■ Draw Tab, Clipboard; Paint Tab, Clipboard: 
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■ Keys: Delete; Alt, D, CX; Alt, P, CX

Cut, Copy and Paste
Once an area has been selected with the selection tools, it can be cut and copied onto the 
clipboard. 

In the Draw window, only objects that are completely enclosed by the selection line will be selected.

Cut
Use Cut  to cut the selected part of the drawing to the clipboard, where it can be pasted 
into the same file or a new drawing.

Cutting to the clipboard replaces the contents previously stored there.

Shortcuts
■ Draw Tab, Clipboard; Paint Tab, Clipboard: 
■ Keys: Ctrl + X; Alt, D, CU; Alt, P, CU

Copy
Use Copy  to make a copy of the selected part or all of the drawing and place it on the 
clipboard, where it can be pasted into the same file or a new drawing.

Copying to the clipboard replaces the contents previously stored there.

Shortcuts
■ Draw Tab, Clipboard; Paint Tab, Clipboard: 
■ Keys: Ctrl + C; Alt, D, CC; Alt, P, CC

Paste
Use Paste  to place part or all of a drawing that has been cut or copied to the clipboard 
onto the screen. The pasted area appears in a highlighted box, ready to be moved or 
altered.

Shortcuts
■ Draw Tab, Clipboard; Paint Tab, Clipboard: 
■ Keys: Ctrl + V; Alt, D, CP; Alt, P, CP

Duplicate
Use Duplicate  to make a copy of the selected part or all of the drawing, which is 
automatically pasted on the Canvas below and to the right of the original. 

Shortcuts
■ Draw Tab, Clipboard; Paint Tab, Clipboard: 

■ Keys: Alt, D, CD; Alt, P, CD
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Undo and Redo
Undo
Use Undo  to reverse the last action that has been applied to the picture on the screen, 
such as moving, deleting or mirroring an area, drawing a line, box or ellipse, or an effect 
that has been applied. Unlimited Undos are possible in the Draw window.

Only actions that change the picture can be reversed using Undo on the Draw window. For example, the 
Zoom commands cannot be reversed using Undo.
The Undo and Redo steps are reset when a new picture is opened.

Shortcuts
■ Quick Access Toolbar: 
■ Keys: Ctrl + Z

Redo
Use Redo  to reverse any actions that have been undone. Redo only works if nothing 
has happened after the last Undo. For instance, if you draw a line, then Undo and draw a 
rectangle then it is not possible to Redo the line because something different has 
happened instead. Unlimited Redos are possible in the Draw window.

The Undo and Redo steps are reset when a new picture is opened.

Shortcuts
■ Quick Access Toolbar: 
■ Keys: Ctrl + Y
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4Creating a Drawing
A full range of drawing functions is available for vector graphics files (easily resizable 
images using lines, curves and shapes). Use the Draw tab to select, organize and edit your 
drawing.

Use the design panel to select colors, and to draw and edit lines and fill areas.

After drawing lines and areas, use the Multiply feature (see “Multiply” on page 71) to repeat them in your 
drawing.

Creating Drawings
Create your designs using the drawing tools and Gallery designs. Save or Export the 
designs as drawings or pictures.

Select part or all of the drawing Group or Ungroup the selected objects

Make and Uncombine Holes

Cut, copy, paste or delete the selected objects

Snap to Grid or Line

Send the selected object(s) to the Paint tab

Create Motifs

Swap the line and fill colors

Pick the line color, or set no line

Pick a fill color, or set no fill

Place points or draw a Bezier line

Trace the background picture
Add, remove, or adjust the points in a line 

Convert points in a Bezier line

Align the objects in your drawing

Set the line width

Draw a freehand line, and set the smoothing

Cut or join lines

Convert between Point and Bezier lines

Rotate and transform objects in your drawing
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The Freehand, Point and Bezier Draw features allow you to work in detail. Draw an outline, 
place points, or draw Bezier curves freely or over a picture to create your design.

Design Choices
Adjust designs using easy editing features: Navigate around the design with the Filmstrip. 
Grouping features allow you to keep smaller parts of your design together.

Choose Drawing Colors
Colors and the Color Palette
Use the Color palette to choose the colors for 
drawing Lines and Fills.

The Color palette provides 40 commonly used 
colors. Click on a color in the palette to place it in 
the Design Panel as the Line or Fill color.

Colors Area
The Colors area at the top of the Design Panel displays the currently selected Line and Fill 
colors. The top color is the Line color and the lower color is the Fill color.

Change a Color in the Colors Area
■ Click the drop-down menu for Line or Fill, then click on a color from the Color palette to 

select it as the Line or Fill color.
■ To choose a color that is not in the Color palette, click More Colors in the palette to bring 

up the Colors dialog box. (After a color is chosen, it will be placed as the Line or Fill color.)

■ To select a color from the picture on the screen use the Pick Line Color  or Pick Fill 

Color  function in the Drawing panel.

Pick Line Color
Use Pick Line Color  to select a color from the picture on the screen and make it the 
Line color in the Color box.

This is useful for choosing colors from the picture for drawing that do not appear in the 
Color palette.

Shortcut

■ Draw Windows Control Panel, Line: 

Change the Color

See more colors

Select a color

Change the Color

See more colors

Select a color
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Pick a Color for Line Color
1 Click Pick Line Color . The pointer changes to an eyedropper .
2 Click the desired color in the drawing or background picture to make it the Line color.

Remove Line Color
Use Remove Line Color  to draw a fill area with no surrounding line. 

Shortcut
■ Draw Windows Control Panel, Line: 

Line Width 
Select a line width from the drop-down list in the Line section. The 
available widths are 0.1, 0.25 and 0.5mm, and 1, 1.5, 2, 2.5, 3, 3.5, 4, 5, 6, 
7, 8, 9 and 10mm. The default width is 0.5mm.

Swap Colors
Use Swap Colors  to switch the line and fill colors for the selected 
object, or before creating a new object.

Shortcut
■ Draw Windows Control Panel, Line: 

Pick Fill Color
Use Pick Fill Color  to select a color from the picture on the screen, or other objects in 
the drawing, and make it the color in the Fill color block for drawing. Also use Pick Fill Color 
to change the Fill color for the selected object or objects.

This is useful for choosing colors from the picture for drawing that do not appear in the Color palette.

Shortcut

■ Draw Windows Control Panel, Fill: 

Pick a Color from the Picture for a Fill
1 Click Pick Fill Color . The pointer changes to an eyedropper .
2 Click the desired color in the drawing or background picture to make it the color for the Fill color 

block. 

Remove Fill Color
Use Remove Fill Color  when you do not want a fill within a closed line. 

Change the Color

See more colors

Select a color
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Shortcut
■ Draw Windows Control Panel, Fill: 

Colors Dialog Box
The Colors dialog box is used to choose a new color for 
the Line, Fill or Paint color.

When the Colors dialog box appears, it shows the 
Standard color selection. If desired, click one of the 
Standard colors. A highlight shows the selected color. 
The New/Current box shows the difference between 
the newly chosen color and the color currently used.

Click the Custom tab to be able to select any of the 16 
million RGB colors.

Click in the blended color palette to choose a basic 
color, then use the slider at the side to choose the 
desired brightness level. The HSL and RGB values are 
updated as you change the color and the color is 
previewed in the New/Current box.

You can also directly enter Hue, Sat(uration), 
Lum(inance) (HSL) and/or Red, Green, Blue (RGB) 
values. Alternatively, use the up/down buttons on each 
of the HSL and RGB value boxes to make fine 
adjustments to the color.

Color Models

Hue, Saturation, Luminance (HSL) Color Model
Hue is the color (red, yellow, green, or blue) for the selected color, expressed as a value 
between 0 and 239. Saturation (Sat) is the strength or purity of color in a specified hue. 
This is related to the amount of gray in it and is measured from 0 (completely gray) up to a 
maximum of 240 (no gray). The higher the saturation, the purer or more vivid the color. 
Luminosity (Lum) is the intensity of lightness or darkness in a color, specified by a value 
between 0 (black) and 240 (white). If Saturation is 0, the Luminosity setting specifies a 
shade of gray.

Red, Green, Blue (RGB) Color Model
The RGB model, one of the Additive Color models, is used on computer monitors. It has 
three primary colors — red, green, and blue — that it creates by emitting light. These 
three colors are combined in various proportions to produce all the colors displayed on 
your screen. They are referred to as additive because they combine to produce white. 
Primary colors are measured as a value from 0-255. The colors produced by combining the 
three primaries are a result of the amount of each of those shades present. For example, 
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pure red has a red value of 255, a green value of 0, and a blue value of 0. Yellow has a red 
value of 255, a green value of 255, and a blue value of 0. If Red, Green and Blue are set to 
zero, the color is black; if all three are 255, they produce white.

Changing the Colors for Lines and Fills
You can change line and fill color for the selected block in the Design Panel.

Select a block, and the Line and Fill colors become those for that block. Change the colors, 
then deselect the block.

See “Change Color and Other Properties” on page 52.

Change the Colors for an Existing Line and Fill
1 Click to select a block of objects. The block is surrounded by a box.

The objects can be a variety of colors.
2 Look at the Design Panel, the Line and Fill color are those for the selected block.
3 In the Line section select a color and the width that you want to use, or select Remove Line Color .
4 In the Fill section select a color for the Fill or choose Remove Fill Color .
5 All of the objects in the block change to your selected color, Line and Fill type.
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Drawing Lines
Freehand Draw
Use Freehand Draw  to draw a line that follows the movement of the pointer. Adjust the 
flow of the line with the smoothness options. Freehand Draw is enabled until another tool 
is selected.

Shortcut
■ Draw Windows Control Panel, Draw 

Draw a Line with Freehand Draw
1 Select the desired line color from the Color palette. Use Pick Color  if you want to select colors 

from the picture.
If you want a fill, also choose a Fill color.

2 Select a line thickness option from the drop-down list in the Lines section.
3 Click the Freehand Draw icon .
4 If desired, change the line smoothness by clicking on the desired 

setting in the Smoothness Options menu.
5 Click and drag across the Canvas from the desired start point to the 

desired end point to draw a line. A line appears showing the 
freehand line as it is drawn. 

6 Lift the pen or release the mouse button and the freehand line is 
completed. Each time you drag and release a new freehand line will 
be drawn, until another feature is selected.

Smoothness Option
When the line is drawn it is converted into points. How smooth the line is will depend on 
which option is set.

Point Draw
Use Point Draw  to place points from which a line will be made. Point Draw is a good 
way to draw either a curved line, or one with straight sections. 

The minimum number of points is two (which forms a straight line). Three points form an angled line. The 
line is smoothed after placing four or more points. Hold down Shift to place straight sections.
Point Draw is enabled until another tool is selected.

Shortcut
■ Draw Windows Control Panel, Draw: 

Very Smooth Smooth Minimal Smoothing

The line is greatly smoothed, with 
very few points.
This is the default option.

The line is slightly smoothed, 
with fewer points.

The line is represented as a 
series of points, with minimal 
smoothing.
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Using Point Draw
1 Select the desired line color from the Color Select panel. Use Pick Color  if you want to select 

colors from the picture.
To make an enclosed area, also choose a Fill color.

2 Click the Point Draw icon .
3 Click a series of points on the Canvas from the desired start point to the desired end point to draw a 

smoothed line. The points (nodes) are displayed as circles.
4 Right-click on the Canvas to place the line. Each time you click, a point for a new line will be placed 

until you select another feature.

Straight and Curved Lines
Hold down Shift while placing a point to make an angled section. The point will be 
displayed as a square, and that part of the line will be converted to points with no curves.

Draw Straight and Curved Lines
1 Select the desired color in the Color palette.
2 Click the Point Draw icon .
3 Click seven points in a zigzag line, following the squares on the drawing area grid.

The points formed where you clicked are round.
4 Right-click the mouse button to draw the line. A curved line is drawn, using the points that you 

clicked on the drawing area.

5 Hold down the Shift key and click seven more points.
The points are now square.

6 Right-click the mouse button to draw the line. This time the line has straight sections.

Bezier Draw
Use Bezier Draw  to draw shapes with finely graduated curves. Control the exact shape 
of the line using the black handles to either side of the points you place.

The points (nodes) for Bezier lines are always square.
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Click to place Corner points, or click and drag to place curve points 
with handles.

For information on Control Points and the other Bezier Line editing tools, see 
“Convert Points” on page 49.

Creating Bezier Lines
When creating Bezier lines:

• Click without dragging to create a Corner point (no handles)
• Click and drag to create a Curve point (the handles are initially symmetric)

Use the Shift key while drawing to affect how the handles are placed:

• Hold down the Shift key while dragging to place the first handle opposite the position 
where the key was pressed, and the second handle where the mouse button was 
released (the handles are asymmetric and can be angled  ).

• Hold down the Shift key before clicking, then drag and release. A single handle is placed 
where the mouse button was released .

Editing Bezier Lines
When a point is dragged, its handles move with it, keeping the same angle and distance.

• The handles on a Curve point can be moved independently along the straight line 
between the point and handles.

• Hold down the Shift key while dragging a handle to create an angle at the 
point between the two handles.

• Use Insert Points  and Delete Points  on the Design Panel to add and 
remove points from the Bezier line.

Shortcuts
■ Draw Windows Control Panel, Draw:
■ Keys: Alt, P, BM

Draw a Circle in Bezier Mode
1 Click the View tab, and ensure that Grid size is set to 10mm, and that the canvas is set to 100mm x 

100mm.
2 Click the Draw tab.
3 Ensure that Fill is not selected (Remove Fill Color  should be highlighted).
4 Select a color for your line.
5 Click Bezier Draw  to select (highlight) it. The Bezier Draw pointer appears .
6 Click to place a point, then click to place three more of these square points in a rough curve.
7 Right-click to finish the line. The points are joined by straight lines.

These are Corner Points, in Bezier Mode they are joined by straight lines.
8 Click Undo  to remove the line.
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9 Starting 2 squares above the center of the canvas, click and drag to 
the right one square, to the crosshairs of the next grid square.

10 Release the mouse button.
A white square (a Point) appears at the placed where you clicked, and a 
black handle appears at the place where you released the button. This is 
the forward handle.

11 Note that a second handle has appeared the same distance behind 
the white point.
This is the backward handle, it is the same distance from the white point 
as the forward handle (it is symmetrical).

12 Starting 2 squares to the right of the center of the grid, click and drag 
downwards one square, then release the mouse button.
A curved line appears between the two square white points.

13 Starting 2 squares below the center of the grid, click and drag one 
square to the left to place the next section of the curved line.

14 Then, starting 2 squares to the left of the center of the grid, click and 
drag one square upwards to place another section of the curved line. 
You should now have three quarters of a circle.

15 Move the pointer over the square white point on the right. The 
pointer changes to the Move pointer .

16 Drag the point and place it exactly where the grid lines cross.
17 Move the pointer over the forward handle for that point (the black 

handle below the point that you just moved).
18 Drag the handle a about half a square downwards. The backward 

handle for this point moves the same distance upwards.
While you are still placing points, if you adjust the handles they behave symmetrically. You can also drag to 
add symmetrical handles to a Corner point.

19 Move the handle to the right and left.
Note that the curved line changes shape as you move the handle.

20 Move the forward handle so that both handles are over the cross 
hairs of the squares above and below the point, and so that the line 
between the handles runs along the grid line.

21 If needed, adjust the other points and handles so that you have a 
smooth three quarters curve.

22 Move the pointer over first point that you placed until it becomes a 
cross.

23 Click on that original point to form a circle.
Alternatively, right-click and select Finish and Close Line in the 
context menu to place the line. 

Edit a Bezier Line
24 In the Draw section of the Design Panel, click Edit Points . The 

points and their handles are displayed.
25 Move the pointer over the handle above the point on the right (the 

backward handle for the second point in the line).
26 Drag the handle a short distance downwards. This time the handle 

below (the forward handle) does not move, and the shape of the 
circle distorts.
When editing a line the points are Curved, and not Symmetric. The 
handles can be moved independently along the straight line.

27 Drag the handle up to its previous position and the shape becomes a 
circle again.

28 Hold down the Shift key and drag the handle to one side. A corner is 
created in the shape.
Use the Shift key to create a corner or other angle in the line.
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29 In the Points section of the Design Panel, select Convert Points to Curve . The pointer changes to 
the Convert Points to Curve pointer .

30 Click on the point. The handles become symmetrical, and the shape you drew becomes a circle again.
For more information on Control Points and the other editing tools, see “Convert Points” on page 49.

31 In the Points section of the Design Panel, select Convert Points to Corner . 
32 Move the pointer over one of the points in your line. The pointer 

changes to the Convert Points to Corner pointer ..
33 Click on the point. It now has no handles, and the sections of the line 

by it are straight.
There are no handles to drag, so you can only change the line by moving 
this Corner Point. Use Corner Points for straight lines.

34 In the Points section of the Design Panel, select Convert Points to 
Curve .

35 Click on the corner point. It changes back to a curved point.
36 Click Edit Points .
37 Drag the upper handle downwards very close to its point and release 

the mouse button. The handle vanishes, and the section of the line 
without a handle becomes straight.

38 Drag the other handle upwards. It also vanishes.
This is another way of creating a corner point.

39 Select Convert Points to Curve  and use it to change the corner 
point back to a curved point.
You can use Convert Points to Curve to regain use of both handles.

40 Right-click to deselect Convert Points to Curve.
To create a corner point with full control over the angle of the lines, hold 
down Shift and click the point. You can then move the handles 
independently.
To create a flower design from a motif using Bezier lines see “Draw a 
Flower using Bezier Curves” on page 35.

Draw a Flower using Bezier Curves
1 Open mySewnet™ Draw & Paint, and in the View tab ensure that Grid size is set to 10mm, and that the 

canvas is set to 100mm x 100mm.
2 In the File menu, click Open .
3 Load the picture file 'Motif Flower.png’ from the samples area on the website: 

www.premierplusecq.com
4 Drag the Background slider to the left so that the picture is very pale.
5 In the Design Panel, ensure that Fill is not selected (Remove Fill Color  should be highlighted).
6 Select a color for your line.
7 Set the Line width to 0.5mm.
8 Click Bezier Draw  to select (highlight) it. The Bezier Draw 

pointer then appears .
See “Draw a Circle in Bezier Mode” on page 33 for the essentials 
of drawing Bezier lines.

9 At the left side of the base of the petal at the top, click and 
drag up and slightly to the left, then release the mouse 
button.

10 Starting where the petal to the left meets the petal you are 
drawing, click and drag upwards a short distance to where 
the next set of grid lines cross.

11 Click (without dragging) to place a point at the tip of the 
petal. This is a Corner point.

12 Move the pointer over the second square white point. The 
pointer changes to the Move pointer .
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13 Drag the point a short distance up and to the left, along the 
outline of the petal until the curved line underneath fits the 
outline of the drawing.

14 Click and drag downwards a short distance from the mid 
point of the right side of the petal.

15 Click to place a single point where the line touches the next 
petal.
As you become more skilled, try clicking and dragging to place 
a curved line using a single point at the base of the petal.

16 Right-click to place the line.
The curve of the line will probably need some adjustment, but 
this is better done later, after you have placed lines for the other 
petals.

17 At the left side of the base of the petal to the right of the one 
that you just drew, click and drag upwards a short distance, 
then release the mouse button.

18 Starting where the petal to the left meets the petal you are 
drawing, click and drag diagonally towards the top right 
corner of the grid.

19 Release the mouse button when you reach the grid line 
above.

20 Click (without dragging) to place a point at the tip of the 
petal.

21 From the mid point of the right side of the petal, click and 
drag diagonally towards the bottom left corner of the grid.

22 Click to place a single point where the line touches the next 
petal.

23 Use the Move pointer to adjust the position of the white 
squares so that the curved line fits the picture behind.
You can further adjust the Bezier line using the black handles.

24 Right-click to place the line.
25 Starting at the bottom left of the third petal, click and drag a 

short distance diagonally to the right to place the first point.
26 Where the outline of the petal meets the grid, click and drag 

a horizontal line a short distance to the right to place the 
next part of the curve.

27 Click to place a point at the tip of the petal.
28 Mid way down the other side of the petal, click and drag to 

the left and slightly down to place the next point.
29 At the base of the petal, click to place a final point, then 

right-click to place the line.
30 Place Bezier curve lines to draw the other petals, finishing at 

the petal to the left of where you started.
If you move the black handle to the left or right as you draw, 
you can place the curve to follow the outline, often with no 
need for later editing.

31 Right-click to finish placing the Bezier line.
32 Click outside the design to deselect the final petal.
33 Click the Line color block and choose a golden yellow color.
34 Click the Fill color block and choose a pale yellow color.

The Fill color changes to your selected color from no color.
35 Click Bezier Draw  to select (highlight) it. The Bezier Draw pointer appears .
36 Starting at the top of the center of the flower, click and drag a short distance to the right, then release 

the mouse button.
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37 Click and drag vertical and horizontal lines of similar lengths to place the other three points creating 
the circle.

38 Right-click to place the center of the flower.
39 Click Edit Points . The points you drew for the center of the flower can be seen.

40 In the FilmStrip, click on each petal in turn, and make a note of the ones you will need to adjust.
41 Adjust the handles on the points to make the Bezier line follow the 

background.
If the handles from two different points overlap, move both nearer to 
their own point, to smooth the curve. For more information on editing, 
see “Edit a Bezier Line” on page 34.

42 When you have made your changes on one petal, select the next 
petal in the FilmStrip and adjust that one.
If you find that one of corner points actually has very short handles, 
either use Convert to Corner  in the Draw tab to change it to a corner, 
or drag the handles sufficiently close to their point that they vanish.

43 Save your flower. You can adjust it further when you open the file 
again.
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Snap to Line
When the Snap to Line  option is selected, if the mouse pointer is close to an existing 
line, any points placed will move on top of the old line, and the new line will snap to the 
existing one. 

Snap to Line works with Point Draw  and Bezier Draw , and when using Edit 
Points .

Snap to Line allows you to place points so that they align with other objects cleanly and without a gap.

You can use Snap to Line  when editing. See “Snap to Line” on page 46.

Shortcuts
■ Draw Tab, Snap: 
■ Keys: Alt, D, NL

Snap to Grid
Use Snap to Grid  to align objects to the Grid lines when they are drawn using Point 
Draw , Bezier Draw  and Insert Shape , or when they are moved.

Shortcuts
■ Draw Tab, Snap: 
■ Keys: Alt, D, NG

Closing Lines
You can join lines to themselves when using Freehand Draw , Point Draw  and Bezier 
Draw .

Use Multiply to automatically create copies of lines.

Closed Lines
If a line is drawn close to its own starting point, then the mouse 
pointer will change to a cross . 

If that line is completed while the pointer is a cross, the line will be 
closed to form an area that may be filled.

Trace Line
Use Trace Line  to trace the outline of a background picture to create a line drawing. 
Use the Color Tolerance slider to select the desired part of the picture.

Place points with Snap to Line Lines snapped together
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Use Trace Area to trace a picture with no outlines.

Shortcuts
■ Draw Windows Control Panel, Draw: 

Trace a Picture with Trace Line
1 In the Paint tab, load a picture with clear outlines, or a line drawing.

Trace Line finds the center of a line or area when tracing. Use Trace Area, 
or Trace Area & Hole to trace a filled area without clear outlining.

2 In the Design Panel, click Trace Line .
3 Hover the pointer over the outline that you wish to trace.

A red and blue highlight on the Canvas shows the outline that will be 
traced. 
To find an outline, it may be best to zoom in and to fade the background 
on the View tab.

4 Drag the Color Tolerance slider below the Trace icons until the 
required part of the picture is selected.

5 Click to trace the outline.
Your traced outline will appear in the FilmStrip.

Trace Area
Use Trace Area  to trace a background picture with no outline to create a filled drawing, 
or a line drawing. Use the Color Tolerance slider to select the desired part of the picture.

Use Trace Line to trace a picture with good outlines to create a line drawing.

Shortcuts
■ Draw Windows Control Panel, Draw: 

Trace a Picture with Trace Area
1 In the Paint tab, load a picture without clear drawn outlines.

Trace Area finds the outline of an area when tracing. Use Trace Line to 
trace a clear outline, or Trace Area & Hole to trace a filled area with a 
hole.

2 In the Design Panel, click Trace Area . 
3 Hover the pointer over the area that you wish to trace.

A red and blue highlight on the Canvas shows the area that will be 
traced. 
To view the area that you have placed, it may be best to zoom in and 
to fade the background on the View tab.

4 Drag the Color Tolerance slider below the Trace icons until the 
required part of the picture is selected.

5 Click to trace the area in the picture.
Your traced area will appear in the FilmStrip.
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Trace Area & Hole
Use Trace Area & Hole  to trace an area of a background picture that includes a hole to 
create a filled drawing, or a line drawing. Use the Color Tolerance slider to select the 
desired part of the picture.

Shortcuts
■ Draw Windows Control Panel, Draw: 

Trace a Picture with Trace Area & Hole
1 In the Paint tab, load a picture without clear outlines.

Trace Area & Hole finds the outlines of an area when tracing to trace a 
filled area with a hole.

2 In the Design Panel, click Trace Area & Hole . 
3 Hover the pointer over the outline that you wish to trace.

A red and blue highlight on the Canvas shows the outside of the 
area that will be traced, and any holes in the area are highlighted 
by a green and yellow dashed line. 
To view the area that you have placed, it may be best to zoom in and 
to fade the background on the View tab.

4 Drag the Color Tolerance slider below the Trace icons until the 
required part of the picture is selected.

5 Click to trace the area in the picture.
Your traced area will appear in the FilmStrip.
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Insert Tab
Use the Insert tab to add Shapes, Lettering and Designs to your drawing.

Drawing Shapes
Insert Shape
Use Insert Shape  to add shapes to the drawing. The shape will be drawn as a closed 
line, that may be filled. Select your shape from the drop-down list. 120 different shapes are 
available.

Hold the Shift key down when resizing with Insert Shape  to keep the original proportions of the shape. 
For example, use Shift to draw a square rather than a rectangle, or a circle instead of an ellipse.
If Snap to Grid is used when drawing a shape, the shape will snap to the grid lines.
Use Multiply to automatically create copies of shapes.

Shortcuts
■ Insert tab, Shape: 
■ Keys: Alt, I, S

Draw a Shape
1 Select the desired line and fill colors and the line width.
2 In the Insert Shape drop-down menu, select a shape.
3 Click the Insert Shape icon . The shape is placed on the 

canvas.
4 Drag the corner handles to resize as desired.

To resize proportionally (so that a square remains square), place the 
pointer over the corner handle so it becomes a double-arrow pointer, 
then hold down the Shift key and drag.
Hold down Ctrl to resize from the center. By default, shapes are 
drawn from the corner.

5 Click outside the shape to deselect.
6 If the shape needs to be moved, click to reselect, then move.

Alternatively, use one of the select tools to move the shape.

Shape Type
Select one of 120 shape types from a drop-down list.

Add designs to your drawing

Create Lettering to add to your drawing

Choose a Shape to add to your drawing

Send the selected object(s) to the Paint tab
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Insert Lettering
Use Insert Lettering  to add text to your picture in any TrueType® or Open Type® font 
available on your computer. Text is drawn using the selected line and fill colors. 

Choose from Regular, Bold, Italic or Bold Italic styles, and adjust the font size in points. 
Then enter the desired text and click Insert Lettering . The text then appears in the 
center of the canvas in a highlighted box that may be moved, resized or rotated. Create 
multi-line text by pressing ENTER while typing in the Text box.

Use the Alignment tools to align multi-line text to the Left , Center  or Right .

Shortcut
■ Insert tab: 
■ Keys: Alt, I, L

Add Lettering to Your Drawing
1 Select the desired colors for line and fill in the Design Panel. 

Use Pick Line Color  or Pick Fill Color  to select colors from the picture.

2 Click the drop-down arrow for the Font and 
select the desired TrueType® Font installed on 
your computer.

3 Click the drop-down arrow for Style and choose 
Regular, Bold, Italic or Bold Italic.

4 Set the size in points by typing in a number, or click on the drop-down arrow and choose a point size.
5 Choose the Alignment for your text.
6 Click in the Text box and the arrow cursor becomes an I-bar. 
7 Type the desired text. Press Enter to create a new line and type more text.
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8 Click the Insert Lettering icon . The lettering is placed on the canvas. The selection box has 
handles to adjust it.

9 If desired, use the resize handles to make the text bigger or smaller. Hold down Shift to resize 
proportionally, and Ctrl to resize from the center. Use the rotate handle to rotate the text to any 
degree.

10 Click anywhere outside the box to deselect.
Use Multiply to automatically create copies of the text.

Design Gallery
Use the Design Gallery  to add any of the clipart pictures included with your 
mySewnet™ Draw & Paint. An added Gallery design is automatically selected, ready to be 
moved or copied.

To see the name of a Gallery design, position the arrow pointer over the desired 
thumbnail. A label showing the file name will appear.

Use Multiply to automatically create copies of Gallery designs.

Shortcut

■ Insert tab: 
■ Keys: Alt, I, M

Add a Gallery design to Your Drawing
1 Click the Design Gallery icon  and the Viewer dialog box will be displayed.

2 To look at Gallery designs in a different folder, select a folder in the browse pane on the left.
The browser only looks for Gallery designs folders in ProgramData\mySewnet\Embroidery1\Gallery

3 Scroll down to see more Gallery designs, if available.
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4 Click a thumbnail picture to select a Gallery design, then click the 
Open button at the bottom of the window. Alternatively, double-
click on a thumbnail picture to load the Gallery design onto the 
screen. The Gallery design is placed in the picture with a selection 
box around it.

5 Click and drag the newly placed Gallery design to the required 
position on your picture. You can also resize the Gallery design, and 
flip it or rotate it. You may need to move the Viewer dialog box out 
of the way to position the Gallery design where you want it (click 
and drag the Viewer dialog box using its title bar).

6 Use the scroll bar on the right to display all the Gallery designs in 
the folder, and click a picture to choose a new Gallery design.

7 Continue adding Gallery designs as required. When you select the 
next Gallery design, the previous design is deselected.
Each Gallery design is inserted as a group, so it can be separately 
selected later.

8 Click Close to finish adding Gallery designs.

Insert File
Click Insert File  to display the Open dialog box to add a drawing from your computer 
to your design. See “Insert” on page 8.

Shortcut

■ Insert tab: 
■ Keys: Alt, I, F
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5Editing Drawings

Editing Tools
The editing tools are found on the Design Panel and the Draw tab. The editing tools are 

Edit Points , Insert Points , Delete Points , Knife , Join  and Make Holes .

Editing Individual Point Lines
In the Draw window of mySewnet™ Draw & Paint, all drawings are made up of lines or 
groups of lines (objects), and each line is defined by a series of points (nodes). You can 
select any individual line and change it by adjusting, adding or deleting points. You can 
also cut lines and groups of lines with the Knife .

Use the Zoom Bar to zoom in close enough to see the separate points clearly.
Point types vary according to the form of the line.

When a line is first drawn, the end points are round unless Shift was used.

Round Points
Round points indicate a curved line. 

You can change a round point to a square point by holding down 
Shift and clicking the point. To change it back, hold down Shift and 
click the point again.

Square Points
Square points indicate a straight line with angled sections. 

You can change a square point to a round point by holding down Shift 
and clicking the point. To change it back, hold down Shift and click the 
point again.

Edit Points
Use Edit Points  to change the position of the points on the currently selected line. Edit 
Points is enabled until another tool is selected, or you right-click to deselect. 

If you edit the points of a filled object, the fill will adjust to the new shape.

Shortcut
■ Draw tab, Points: 

Editing the Points in a Line
1 Click the Edit Points icon .
2 Click the line that you want to edit. Its points will be displayed.
3 Click and drag a point to change the shape of the line. Lift the 

pen or release the mouse button to place the point in its new 
position.
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The Edit Points tool is active until another feature is selected, or you right-click to deselect.
Moving a round point affects the two sections of line to either side of that point. This ensures line 
smoothness. 

Reshaping a Curved Line
1 Draw a curved line.
2 Click the Edit Points icon .
3 Click the line you just drew. The line is defined by a series of round 

points.
4 Click and drag one of the points in the middle of the line.
5 Move the point around freely. You will see the line flex not only up to 

the adjoining point, but to the next point on either side. (The line 
beyond the second point is unaffected.)

6 Release the mouse button. The line takes on the new shape.
7 Hold down Shift and click the points to either side of the 

point you were moving. They become square.
8 Move the point around again. This time the line to the far 

side of the square points will not flex.

Snap to Line
Snap to Line  is available as an option for Edit Points. When selected, if the mouse 
pointer is close to an existing line, the pointer will change to a diagonal bar .

You can use Snap to Line  when drawing. See “Snap to Line” on page 38.

Using Snap to Line
1 Use Freehand Draw  to draw two separate curved lines.
2 Click the Edit Points icon .
3 Select Snap to Line .
4 Click one of the lines you just drew.
5 Click and drag one of the end points towards the middle of the 

other line. As it nears the line, the pointer changes to a diagonal 
bar .

6 Release the mouse button or lift the pen. The two lines are neatly 
joined.

7 Click one of the round points in the middle of the line. Drag the 
point towards and over the other line. Note how the pointer 
changes as you pass over the other line.

Join
Use Join  to join two open lines together.

You cannot join closed lines (shapes) with Join.
Click Join , and all open line endings are highlighted with a circular handle. Click the 
two handles to be joined, or drag one on top of the other.

The line will take on the color of the second handle clicked.
If you Join the two ends of the same line, a closed area is formed.

Joining Two Lines
1 Draw several lines with different colors.
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2 Click Join .
All open line endings are highlighted with a circular handle.

3 Click the end handle of one of the lines to be joined.
4 Click the end handle of the other line to be joined.

The two lines are joined with a straight section, and the joined line takes on the color of the second 
line selected.
You can also drag one handle on top of the other to join two lines.

5 Right-click to deselect.

Delete Points
Use Delete Points  to remove the currently selected point. 

If a middle point is deleted, the line will be redrawn to follow the path between the points 
that are left. 

If an end point is deleted from an open line, the line will be shortened and the next point 
in the line will become the end point. 

Delete Points is enabled until another tool is selected, or you right-click to deselect.

Draw some lines Click Join  to highlight the line ends.

Click the handle for the first line to join. Click to join the two lines.
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Shortcut
■ Draw tab, Points: 

Delete a Point
1 Click the Delete Points icon .
2 Click the line that you want to edit. The points will be displayed.

3 Click each individual point that you want to delete.

 
4 The line will be reshaped. The Delete Points tool is active until another feature is selected, or you 

right-click to deselect.

Insert Points
Use Insert Points  to add a point to the currently selected line. 

Insert Points is enabled until another tool is selected, or you right-click to deselect.

Shortcut
■ Draw tab, Points: 

Add a Point to a Line
1 Click the Edit Points icon  to make sure that you are in Edit Points mode.
2 Click the line that you want to edit. The points will be displayed.
3 Click the Insert Points icon . The pointer changes to the Insert Points pointer .
4 Click the place on the line where you want to add a point. 

The line will be reshaped accordingly. The Insert Points tool is active until another feature is selected, 
or you right-click to deselect.

Click the line to display the points Click to add a point
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Converting Point and Bezier Lines
Use the Convert Points functions to change Bezier lines and Point lines.

Convert Points
Use the Convert Points functions Convert Points to Curve  and Convert Points to 
Corner  to change between types of points in a line in Bezier Mode.

For information on how to draw and adjust Bezier Lines, see “Bezier Draw” on page 32.

Convert Points to Curve
Use Convert Points to Curve  to change the selected point in a Point line or Bezier line 
to a Curved point (for Bezier, a point with handles that can be adjusted independently). 
Right-click to deselect the function.

Shortcuts
■ Design Panel, Points: 

Change a Bezier Mode Point to a Curve Point
1 In the Points section of the Design Panel, click Edit Points .
2 Click on a line created with Bezier Draw to show the points that make it up.
3 In the Points section of the Design Panel, select Convert Points to Curve . 

Edit Points  is no longer highlighted.
4 Move the pointer over a corner point in your line. The pointer changes to the Convert Points to Curve 

pointer .
5 Click on the point. It now has two handles, and the dashed line between them is straight.
6 Click to adjust any other points that you want to change in your design.
7 Right-click to deselect the function.
8 If desired, click the Convert Points to Curve  again and repeat.

For more information on how to adjust Bezier Lines, see “Edit a Bezier Line” on page 34.

Convert Points to Corner
Use Convert Points to Corner  to change the selected point in a Point or Bezier line to a 
Corner point (a point with no handles for Bezier). Right-click to deselect the function.

Shortcuts
■ Design Panel, Points: 

Change a Bezier Mode Point to a Corner Point
1 In the Points section of the Design Panel, click Edit Points .
2 Click on an line created in Bezier Draw to show the points that make it up.
3 In the Points section of the Design Panel, select Convert Points to Corner . 

Edit Points  is no longer highlighted.
4 Move the pointer over one of the points in your object. The pointer changes to the Convert Points to 

Corner pointer .
5 Click on the point. It now has no handles, and the sections of the line by it are straight.
6 Click to adjust any other points that you want to change in your design.
7 Right-click to deselect the function.
8 If desired, click the Convert Points to Corner  again and repeat.

For more information on how to adjust Bezier Lines, see “Edit a Bezier Line” on page 34.
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Convert to Point Line
Use Convert to Point Line  to change the selected Bezier Line to a Point Line. 

The change takes place immediately.

Shortcut
■ Design Panel, Points: 

Change a Bezier Line to a Point Line
1 Click on an object created in Bezier Draw.
2 In the Edit section of the Design Panel, click Convert to Point Line . 

The line changes to a standard Point Line immediately.

Curved points are added to the line when it is converted. If you change your mind, use Undo rather than 
converting back. 

3 If desired, select another object and click Convert to Point Line again to repeat.

Convert to Bezier Line
Use Convert to Bezier Line  to change the selected Point Line to a Bezier Line. The 
change takes place immediately.

A smoothly drawn line with the minimum of points is more likely to produce a good result.

Shortcut
■ Design Panel, Points: 

Change a Point Line to a Bezier Line
1 Click on an object created in Point Mode.
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2 In the Design Panel, click Convert to Bezier Line . The line changes to a Bezier line immediately.
If you change your mind, use Undo rather than converting back. 

3 If desired, select another object and click Convert to Bezier Line  again to repeat.
The number of points in the Bezier line will depend on the number of points in the original line. Delete 
points and adjust the handles on the remaining points to optimize the Bezier line.

Knife
Use the Knife tool  to cut the currently selected line, shape or group (object) into two 
parts. 

One part is automatically selected.

The Knife is deselected automatically after use.

Any filled shapes will be converted into lines when cut with the Knife. As the cut lines will still have a fill type 
assigned to them, the fill will be displayed again if those lines are joined to make another shape, or a 
different shape.

Shortcut
■ Draw tab, Points: 

Cut a Shape with the Knife
1 Draw a line, or place a shape.
2 Click Object Select , then click the object that you just drew to ensure it is selected. It is now 

surrounded by a box.
3 Click the Knife Tool icon .
4 Click to one side of the object that you drew, then drag to get to the other side of the object. A 

straight line representing the path of the cut is displayed.

Point Line Converted to Bezier Line
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5 Release the mouse button to cut diagonally across the object with the Knife. It is divided in two, as 
can be seen in the FilmStrip.

6 Right-click to finish using the Knife. One section is selected
The Knife can also be used to cut groups. Load a Gallery design , then cut it with the 
Knife. It will now be displayed as two groups that can be moved separately.

Use the Knife Tool to remove an unwanted section of a drawing, then join the remaining lines to make a 
single line.

Change Color and Other Properties
Once objects have been selected, the line and fill color and other properties of the 
selected block can be changed. 

Select a block to change its properties in the Design Panel.

Change the Color of a Block
1 Select a block of objects of varying colors.

2 In the Design Panel, click on the lower color by the drawing tools, then select a new 
color in the palette. 
To select a new line color, click on the upper color, then select a new color in the palette.

3 Click OK to apply the new color to your selected block.

Select the line Draw the cut line Right-click to end cutting
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Rotate 45º 
Use Rotate 45º  to rotate all selected objects in a block around the Center of 
Rotation .

Shortcuts
■ Design Panel, Edit: 

Transform
Use Transform  to open the Transform dialog, where you can show and change the size, 
rotation and skew of the currently selected block.

Shortcuts
■ Design Panel, Edit: 

Transform Dialog
Use the Transform dialog box to show and change the size, 
rotation and skew of the currently selected block.

Modify the currently selected block as desired, then click OK 
to show your changes on the Canvas.

Click Undo  to reverse your changes.

Size
Show and change the height  and width , or height  
and width  percentage of the currently selected block.

Proportional
Use this option to keep the relative Height and Width in 
proportion when either is changed.

Rotate
Enter an angle , from 0 to 359 degrees, in the Angle box. The preview shows the 
selected angle.

If desired, move the center of rotation before rotating.

Skew %
Skew the currently selected block horizontally and vertically. Enter values in the 
horizontal  and vertical  percentage boxes, then click Apply.

For Horizontal Skew , positive numbers will skew the lower part of the block to the left 
and negative numbers will skew it to the right. For Vertical Skew , positive numbers will 
skew the right part of the block upwards, and negative numbers will skew it downwards.
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Resize a Flower Drawing
1 Click the Design Gallery icon  and the Viewer dialog box will be 

displayed.
2 Browse to the folder Flowers and Leaves, and click to highlight the 

design Orange Flower.
3 Click Open to load the flower design.
4 In the Draw tab, ensure that Object Select  is active.
5 Click the flower to select it.
6 Click Transform . The Transform dialog box appears.
7 In the Size section, ensure Proportional is checked, then change
8 Height percentage to 75%.

The Width percentage will decrease by the same amount, and in the 
background the flower changes in size.

9 In Rotate, click and hold on the up arrow. The flower rotates.
10 Change the width and height percentage Skew to reshape the flower 

design.
11 Click Close. The flower now uses your new settings.
12 Left-click outside the select box to deselect the flower drawing.

Alignment Tools
The Alignment tools allow objects to be aligned precisely. 

The Alignment tools are only available when more than one object is selected.
Select the objects that you want to align, then use one of the alignment tools. 

Objects can be aligned horizontally or vertically. They can also be centered.

Horizontal Alignment
Align objects horizontally with the Horizontal Alignment  tools.

Align Left
Align Left  aligns all selected objects with the left edge of the object furthest to the left.

Shortcut
■ Keys: Alt, D, AL, H, L

Align Center
 Align Center  centers all selected objects horizontally relative to each other. 

Shortcut
■ Keys: Alt, D, AL, H, C

Align Right
Align Right  aligns all selected objects with the right edge of the object furthest to the 
right. 

Shortcut
■ Keys: Alt, D, AL, H, R
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Distribute Horizontally
Distribute Horizontally  aligns all selected objects to be equally spaced horizontally.

Shortcut
■ Keys: Alt, D, AL, H, D

Vertical Alignment
Align objects vertically with the Vertical Alignment  tools.

Align Top
Align Top  aligns all selected objects with the top edge of the highest object. 

Shortcut
■ Keys: Alt, D, AL, V, T

Align Middle
Align Middle  centers all selected objects vertically relative to each other. 

Shortcut
■ Keys: Alt, D, AL, V, M

Align Bottom
Align Bottom  aligns all selected objects with the bottom edge of the lowest object. 

Shortcut
■ Keys: Alt, D, AL, V, B

Distribute Vertically
Distribute Vertically  aligns all selected objects to be equally spaced vertically.

Shortcut
■ Keys: Alt, D, AL, V, D

Center in Canvas
Use Center in Canvas  to move the selected objects to the center of the Canvas.

Shortcut
■ Status Bar: 

Grouping Selected Objects
In the Draw tab you can edit lines or areas individually, in a selected block, or in groups 
which can remain as a section after saving. You can also place groups in larger groups.

When a drawing is loaded using Insert, all sections will be grouped together, ready for moving, resizing 
and so on.
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Group
Use Group  to make a group of all the currently selected objects. Either Group the 
objects permanently, or Group them temporarily while moving or editing them.

A group can be modified in the same way as a block. You can move, resize, skew, mirror and rotate it, and 
change the color of its objects.
Gallery designs  are made from groups. You 
can use the FilmStrip to see the objects inside 
complex group structures such as the Gallery 
design Hearts.ecq in the Objects section of the 
Design Gallery.

Group can only be used in conjunction with one 
of the selection tools.

Shortcuts
■ Draw Tab, Group: 
■ Keys: Alt, D, G

Group Several Objects
1 Use Freehand Draw  to draw several short lines in the drawing 

area.
2 Look at the Group area in the ribbon bar. The tools are currently 

grayed out (unavailable).
3 Use Box Select  to click and drag to draw a rectangle around the 

lines to select them. The Group tools are now active.

4 While the lines are selected as a block, click Group . The block 
will be changed into a group.

5 Move, rotate and resize the group as a single unit.
6 Click outside the group to deselect it. The Box Select tool is now 

active again, and Group is grayed out.
In the same way that an object partially outside the selection does not 
become part of a block, only objects fully inside the selection can 
become part of a group.

Highlighting a Group or Line
You can select existing objects on the Canvas when a selection tool is active.
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1 Place a mixture of lines and groups in the 
drawing area.

2 Right-click on the Canvas to deselect the 
drawing tool.

3 Click outside the drawing area to deselect 
everything.

4 Click to select a line. If it is part of a group the 
whole group will be displayed as a block. If it is 
not, the line will form a block on its own.

5 Move the mouse pointer over the drawing 
area. As it goes over a selected line the pointer 
changes from an arrow  to a four-headed 
arrow .

6 To select all objects at once, click Select 
All .
Highlight each group, or individual line, in turn using the Tab key. Alternatively, view the complete 
structure of your drawing in the FilmStrip.

Ungroup
Use Ungroup  to split the currently selected group into the objects which make it up. 
These may be lines, filled or unfilled areas, or smaller groups.

Ungroup can only be used when a group is selected.

Shortcuts
■ Draw Tab, Group: 
■ Keys: Alt, D, UG

Ungroup Grouped Objects
1 Open the Insert tab.
2 Select the Design Gallery  and 

load a design into the Canvas. 
Click Close.
The design is displayed as a 
group in the drawing area. 

3 Click the Draw tab.
Note that the Group tools in the 
ribbon bar are active.

4 Move the design around the 
screen. It moves as one unit.

5 In the Group section of the Draw 
tab, click Ungroup . The 
group has now become a block.
In the FilmStrip note that there are 
now several objects within the 
block.

6 Move the Gallery design. As it is a block it moves in one piece.
While the block is still selected you can reverse the effects of Ungroup by using either Group or Undo.

7 Click outside the design. A box is no longer displayed around the design.
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8 Click inside the design again. This time only a part of the design is selected. You can move it 
separately.

Use Ungroup followed by Delete, then Group again to remove an unwanted section from a drawing.
If a piece of a drawing is accidentally left behind when you move it, use Undo and Group before trying 
again.

Ungroup All
Use Ungroup All  to split all the groups within the selected group into their individual 
lines and areas.

You can use Undo  to reverse the effects of Ungroup All.

Use Select All  and then Ungroup All to Ungroup whole drawings.

Shortcuts
■ Draw Tab, Group: 
■ Keys: Alt, D, GA

FilmStrip
Use the FilmStrip to view the structure of objects in your drawing. View your drawing 
structure by opening its groups. Examine and move the individual lines or fills (paths) and 
groups within those groups.

FilmStrip Items
The top, or Root, entry in the FilmStrip shows the whole drawing in miniature. It represents 
the Group (object) that contains all the other objects in the drawing.

A Gallery design is a single Group When Ungrouped it is a block. You can move 
a part separately
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Below the top entry, the FilmStrip shows the sequence 
of objects within the drawing. The currently selected 
object is highlighted in the FilmStrip, and objects can 
be selected directly in the FilmStrip. 

Each item in the FilmStrip shows two pieces of 
information: the object and its type.

Object
Each object is represented graphically, showing its 
shape and color. Double-click a group to see the 
objects within it.

Object Type and Name
The name of the object type may be shown. The types 
are Group and Path (for Cardinal Path, or line). Paths 
may be open or closed. Closed paths may be filled or 
unfilled.

Scroll Bar
Use the scroll bar to move rapidly up and down the 
FilmStrip.

Select Objects in the FilmStrip
To select an object, click it in the FilmStrip. If necessary, use the scroll bar on the side of the 
FilmStrip to view the object, or double-click to open the Group it is in. When you edit or 
select a line in the drawing area it is also highlighted in the FilmStrip.

If you have zoomed in, the selected object may not be shown on the visible part of the drawing area. To see 

the object, either Zoom To Canvas  or use the scroll bars on the edges of the drawing area.

You can also select objects using the keyboard. Click on the FilmStrip, then use the arrow 
keys to step up and down the list by one object at a time. Use the Page Up and Page Down 
keys to jump up and down the list one screenful at a time. Use Home to go to the first 
object and End to go to the last object.

Open a Group by double-clicking it, or by clicking on the plus sign  to its left.

To select several objects that are next to each other, hold down the Shift key, and click the 
start and end object in the sequence. 

To select objects that are not next to each other, hold down the Ctrl key and click the 
desired objects.

When selecting a mixture of paths and groups with Ctrl + click, if you want to change their properties, 
select the paths within the groups, not the group headings.

Change the Sequence of Objects
Objects and groups of objects may be moved up and down the FilmStrip with the arrow 
(Layout Order) buttons.

Group Object Layout
Order

Scroll
Bar
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Objects can only be moved within their current group within the FilmStrip. To move an 
object outside its group, Cut and Paste it. Alternatively, use Ungroup, move the object, and 
Group the remaining objects again.

You can move any object in the FilmStrip except the Root (first) entry. 
To delete an object, select it in the FilmStrip and click Delete .

Layout Order
The Layout Order buttons are used to move objects within the FilmStrip.

Move Forwards
Move Forwards  brings the object one step down the FilmStrip.

Move Backwards
Move Backwards  brings the object one step up the FilmStrip.

Move to Front
Move to Front  places the object at the bottom of the FilmStrip or Group.

Move to Back
Move to Back  places the object at the top of the FilmStrip or Group.

Make Holes
Use Make Holes  to create a hole in the fill for a shape. This is done by combining the 
paths (lines) for the selected objects. Make Holes is only enabled when more than one 
filled shape is selected.

The shapes should overlap for Make Holes to show an effect.

Shortcuts
■ Draw Tab, Combine: 
■ Keys: Alt, D, MH

Use Make Holes to Create a Filled Shape with a Hole
1 Use Freehand Draw  or Insert Shape  to draw a filled shape.

Make Holes is grayed out (unavailable) while you do this.
2 Use Freehand Draw or Insert Shape to draw a second filled shape completely inside the first filled 

shape (for example, a circle within a circle).
3 Use Box Select  to select both shapes as a block. Make Holes  is now available.

Check in the FilmStrip to see that both shapes are selected.
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4 Click Make Holes . The shape within a shape is now a filled area with an unfilled hole in it.
All of the combined lines and fills are now the same colors.

Uncombine
Use Uncombine  to break apart an object combined with Make Holes .

Shortcuts
■ Draw Tab, Combine: 
■ Keys: Alt, D, P, U

Uncombine a Combined Object 
1 Use Box Select  or another selection tool to select an object that you combined with Make 

Holes .
2 In the Combine area of the Draw tab, click Uncombine . The combined object is split into separate 

paths, and any holes in fill areas have now gone.
The lines and fills remain the same colors that they were when combined.

Send to Paint
Use Send to Paint  to send the selected vector objects in the Draw window to the Paint 
window as a raster image (area of pixels).

Use Send to Paint to build up your background picture, or even to add a cartoon to a photo!

Shortcuts

■ Draw Tab: 
■ Keys: Alt, D, ST; Alt, I, ST

Draw a filled shape Add a filled shape inside Select Make Holes
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6Motifs and Machine Stitches

Using Motifs
Create and adjust motifs and machine stitches in the Motifs and Stitches  drop-down 
menu.

A motif is a small element in the mySewnet™ Embroidery Software designed so that it will 
repeat along a line or along multiple lines to fill an area. 

You can choose any available motif for motif lines, tapered motifs columns and fill areas. 
The size of motifs can be changed. For motif fill areas, a second motif can be chosen for 
alternating lines, and the spacing, offset and angle of lines can be changed. 

All the system motifs are in the Universal Group. You can use My Motifs for motifs that you 
create.

The default motif is a star, Pattern 5 in the General Motifs 1 category.

Create and modify motifs, and machine stitches for certain machines, using these 
functions.

Insert and Export Motifs
Insert Motif
Use Insert Motif  to open an existing motif 
to modify it, or to create a stitch for certain 
sewing machines.

Use the motif viewer to browse thumbnails 
of motifs before opening them. mySewnet™ 
Draw & Paint displays the Viewer dialog box. 
Choose a Group and a Category to view, then 
load a motif. 

To see the motif number, position the arrow 
pointer over the desired thumbnail. A label 
showing the number will appear.

Shortcuts
■ Draw Tab, Motif: 
■ Keys: Alt, D, M, I

Insert a Motif
1 Click My Motifs, Insert Motif and the Viewer dialog box appears.
2 Click on the drop-down menu on the left to select a motif Group (for example Universal or My Motifs)
3 Click on the drop-down menu on the right to select a Category (for example Candlewicking).
4 Click on a motif thumbnail to load it into the Draw window in mySewnet™ Draw & Paint. The Viewer 

closes.
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Click the down arrow icon  at the left hand side of the dialog box to see more motifs, if available.

Click the exit icon  at the bottom left of the dialog box to exit without selecting a motif.

Export to My Motifs
Use Export to My Motifs  to save the design or selected area on the screen to the My 
Motifs database. There is no confirmation of this action.

Only the motif design is saved, not the color.
The start and end stitches should always be aligned horizontally. If the motif is saved with start and end 
stitches that are not level, or are reversed, the motif is automatically rotated when it is used to make a 
motif fill area or a motif line. The rotation forces the start and end stitches to be aligned from left to right.
If the first and last stitches are not aligned horizontally, a message appears to give you the 
option to add an alignment stitch.

Click Yes to add the alignment stitch and then export the motif to the My Motifs database. 
Click No to export the motif in its current state. Click Cancel to do nothing, which will give 
you to the opportunity to align the start and end stitches as required.

If the start and end points are the same, for example if a closed line or shape is used, a different message 
about start and end points will be displayed, and the design will not be exported to My Motifs. Edit the 
design to give suitable start and end points, then export again.

Shortcuts
■ Draw Tab, Motif: 
■ Keys: Alt, D, M, E



64          mySewnet™ Draw & Paint   Motifs and Machine Stitches 

Manage My Motifs
Use Manage My Motifs  to delete unwanted My Motifs.

Shortcuts
■ Draw Tab, Motif: 
■ Keys: Alt, D, M, M

Delete
To remove an unwanted My Motif, select the desired motif then click Delete. A message 
will appear to ask for confirmation. 

Click OK to remove the motif.

When a My Motif pattern is deleted, this will affect the numbering of all following My 
Motifs. Any design outline files in mySewnet™ Digitizing that used that motif, or any of 
those that followed, will change accordingly.

If there are more than 12 My Motifs, the number at the right-hand end of the slider bar will show how 
many pages of My Motifs there are. Use the slider bar to select the required page of My Motifs.
if there are no My Motifs, an error message will be displayed before the dialog box is opened.

Backing up My Motifs
To backup up My Motifs, use the Backup MySettings feature in mySewnet™ Configure.



mySewnet™ Draw & Paint   Motifs and Machine Stitches              65

Creating Motifs
Creating Motifs
Any drawing can be made into a motif, but for best results use a 
simple design with start and end points that are aligned horizontally 
to the left and right. 

To save the design or selected area on the screen as a motif, use 
Export to My Motifs .

To make a permanent copy of the motifs you create, use Save As  to save the 
design as an .ecq drawing file. This will save the precise position of the nodes that you used, and whether 
they were for curves or corners.
Create motifs manually, or by tracing an existing design loaded as a background picture.

When saving a partially complete drawing to finish creating a motif, save as an .ecq file, then reload the 
file to continue.

Create a Motif
1 In the Draw window, select Point Draw .
2 Place points, using the Shift key to create corner or square points, to draw the 

outline of a tree from left to right. Right-click to finish the line.
Start and finish on the same horizontal line.
The start and end stitches should always be aligned horizontally. If the motif is 
saved with start and end stitches that are not level, or are reversed, a stitch will be 
added, or the motif will be automatically rotated when it is used to make a motif 
fill area or a motif line. The rotation forces the start and end stitches to be aligned.

3 Click Save As  and save the motif design as Tree Outline.ecq.
4 Ensure that the tree outline is selected.
5 Click My Motifs, Export to My Motifs .
6 If the first and last stitches are not aligned 

horizontally, a message appears to give you 
the option to rotate the motif or add an 
alignment stitch. Click the desired option and 
then export the motif to the My Motifs 
database. 
If you want to adjust the motif yourself, click 
Cancel to return to the work area, where you 
can align the start and end stitches as required.

7 If the start and end points are the same, for example if a closed line or shape is used, a different 
message about start and end points will be displayed, and the design will not be exported to My 
Motifs. Edit the design to give suitable start and end points, then use Export to My Motifs again.
If there are more than 12 My Motifs, the number at the right-hand end of the slider bar will show how 
many pages of My Motifs there are. Use the slider bar to select the required page of My Motifs.

Design Size
Motifs should be designed at the size they are most likely to be used, as this will match the 
detail in the motif to the scale at which it is used. If you are likely to use the same motif at 
different sizes, where one size is at least twice as big as the other, make two versions of the 
motif. Decreasing the size of a motif will create too much detail, and increasing the size of 
a motif will give an apparent loss of detail and smoothness.
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The design size of a My Motif in mySewnet™ Draw & Paint is the default size it is set to 
when it is initially selected for use in a motif fill area or a motif line.

Moving Forward
Motifs are generally used as a chain of motifs in a motif fill area or a motif line. Motifs 
should be designed so that when they are used they are connected in sequence at the 
start and end points. Generally, the first and last points should be on the left and right of 
the motif respectively. This is so the motif can be used without it overlapping itself. For 
some motifs, however, it may be desirable to overlap the motif if it is a shape that can be 
nested as it repeats.

Lining Up the Motif
It is desirable for the first and last stitches to be created on the same horizontal line of the 
grid. This is so that the motif will be used with the orientation that is shown on the design 
area. If the first and last stitches are not lined up, the motif will be rotated when it is used 
so that they do line up from left to right.

Use of Nodes
Corner (square) nodes will always be stitched. Curved (round) nodes indicate the line to be 
used, but the program will calculate the number of points (stitches) required to make the 
curve.

Test Stitchouts
Always test your motifs on scrap pieces of the fabric you are going to use. Always use 
stabilizer to help prevent pull on the fabric.

Connecting Parts of a Design
You can only make a motif from an image that is entirely connected. If there is no direct 
connection between parts of the design, they cannot be exported as a motif. Add 
connecting lines to the design in the design area before using Export to My Motifs. 
Alternatively, delete any unconnected details, leaving an outline.

Lead-in and Lead-out Lines
Add lines that lead in and lead out of your design before exporting.

To ensure that the motif is created to line up correctly, use the grid.
The example shows how you might use lead-in 
and lead-out lines; they have been added to 
give the illusion that the car is sitting on the 
road.

Notice that the lead-in and lead-out lines are 
the furthest left and furthest right parts of the 
design.
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Simplifying the Design
There may be too much detail in a design. Use Edit Points  and Delete Points  to 
remove extra details, and smooth outlines.

Use Edit Points  to change the position of the nodes on the currently selected line. Moving a round node 
affects the two sections of line to either side of that node. This ensures line smoothness. You can append 
one line to another by joining two end nodes. The line that is joined to will take on the characteristics of the 
line that does the joining.

Use Delete points  to remove the currently selected node. If a middle node is deleted, the line will be 

redrawn to follow the path between the nodes that are left. Use Add Points  to add a node to the 
currently selected line.

Using Your Motifs in mySewnet™ Digitizing
The motif that you created will be in the My Motifs Category in Manage My Motifs.

You will also be able to see them in the Fill Area and Line Properties dialog box for any 
type of motif line or fill in mySewnet™ Digitizing, and other mySewnet™ Embroidery 
Software modules.

See “Export to My Motifs” on page 63.

Use a Motif that you Created in mySewnet™ Digitizing
1 In mySewnet™ Digitizing select a line or fill area using Motif Line , Motif Fill , Tapered 

Motifs , Shape Fill , MultiWave Fill  or Curved Crosshatch Fill .
2 Right-click the object to open the Fill Area and Line Properties dialog box.
3 In the Group drop-down list select My Motifs. The My Motifs Category is selected automatically.
4 From the Pattern drop-down list select the desired motif.
5 Use Height and Width to set the size of your chosen motif.

When checking a new motif in Fill Area and Line properties, increase the Vertical Gap to see the individual 
rows of the motif.

6 Click OK to place the motif in your line or fill.
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Machine Stitches
Insert Machine Stitch
Use Insert Machine Stitch  to open an existing stitch to modify it, or to export it as a 
motif. mySewnet™ Draw & Paint displays the Open dialog box so you can choose a 
machine stitch design file to open. 9mm, Maxi and Spx files may be loaded.

The following options allow you to specify which file to open:

File Name
Type or select the filename you want to open. This box lists files with the extension you 
select in the Files of Type box.

Files of Type
Select the type of file you want to open, .9mm, .max or .spx files.

Look In
Select the drive or folder containing the file that you want to open.

Shortcuts

■ Draw Tab, Motif: 
■ Keys: Alt, D, H, I
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Export as Machine Stitch
Use Export as Machine Stitch  to save the drawing or selected area as an .spx machine 
stitch for certain sewing machines, or send it to the sewing machine. Save and name the 
design file. mySewnet™ Draw & Paint displays the Export as Machine Stitch dialog.

If the first and last stitches are not aligned, a message appears to give you the option to add an alignment 
stitch.

Maximum Stitch Length
Define a maximum length for the stitch.

Output
Save or send the design as a machine stitch.

Export as Machine Stitch
Click Export As Machine Stitch  to export the stitch, then click Save. The Save As dialog 
for machine stitches is displayed so you can name your stitch. 

Files can be saved in Spx (.spx) format.
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Send to Machine
Use Send to Machine  to send a saved Spx stitch file to your connected machine.

Alternatively, copy the Spx stitch file to a USB Embroidery Stick.

Zoom
Use the Zoom functions to change the view of the stitch.

Use Zoom In  to magnify the view. Move the pointer over the picture and the pointer 
changes to the zoom in pointer . Then either click a point you want to zoom in towards, 
or click and drag a rectangle around the area you want to zoom in to and release the 
mouse button to zoom. When zoomed in, use the scroll bars to move around.

Use Zoom Out  to shrink the view. Move the pointer over the picture and the pointer 
changes to the zoom out pointer . Then click a point you want to zoom out from.

Click Zoom To Fit  to fit the picture to the preview area.

Click Real Size  to view the picture at its real size in pixels. This means that one pixel of 
the picture uses one pixel of the screen.

Shortcuts

■ Draw Tab, Motif: 
■ Keys: Alt, D, H, X
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7Multiply
Use Multiply  to repeat drawings or actions automatically by reflecting across and/or 
down, and by rotating. Symmetrical designs can be created quickly and easily. All changes 
in the drawing, such as adding, editing, pasting and removing lines and groups are 
multiplied.

You can use the select tools, and Group and Ungroup, while Multiply is active.
Multiply can reflect or rotate images. Existing objects will not be affected, but the selected 
objects or any new object that is either drawn or pasted in will be reflected or rotated. The 
blue Multiply reflection lines are shown on the canvas when Multiply is enabled.

Try drawing and inserting designs while Multiply is active.
Click Enable Multiply  on the Multiply tab to turn Multiply on, and click Apply 
Multiply  to place the multiplied designs on the canvas.

Multiply Mode
Use the Multiply Mode functions to set your Multiply style, and to enable Multiply.

Enable Multiply
Use Enable Multiply  to activate the Multiply options.

Only new objects, or objects that were selected when Multiply was started, are affected by Multiply.

Shortcuts
■ Multiply Tab, Multiply Mode: 
■ Keys: Alt, M, E

Apply Multiply
Use Apply Multiply  to place the multiplied designs on the canvas.

Shortcuts
■ Multiply Tab, Multiply Mode: 
■ Keys: Alt, M, A

Cancel Multiply
Use Cancel Multiply  to cancel the current Multiply.

Place multiplied objects on canvas Set options for Horizontal and Tile

Set options for Multiply in Circle

Choose a Multiply mode

Set options for Vertical and TileMultiply the selected objects

Cancel
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Shortcuts
■ Multiply Tab, Multiply Mode: 
■ Keys: Alt, M, N

Circle
Use Circle  to multiply designs in a circle, and to create kaleidoscope style patterns. Use 
the Circle Options to change the number of designs, and to mirror the designs.

Shortcuts
■ Multiply Tab, Multiply Mode: 
■ Keys: Alt, M, MC

Horizontal
Use Horizontal  to multiply designs along a horizontal line. Use the Horizontal Options 
to change the number of designs, the size of the Multiply zone, and to mirror the designs.

Shortcuts
■ Multiply Tab, Multiply Mode: 
■ Keys: Alt, M, MR

Vertical
Use Vertical  to multiply designs along a vertical line. Use the Vertical Options to change 
the number of designs, the size of the Multiply zone, and to mirror the designs.

Shortcuts
■ Multiply Tab, Multiply Mode: 
■ Keys: Alt, M, MV

Tile
Use Tile  to multiply designs within a horizontal and vertical 
grid, from a square blue Multiply zone. 

Use the Horizontal Options and the Vertical Options to change 
the number of designs, the size of the Multiply zone, and to 
mirror the designs.

Shortcuts
■ Multiply Tab, Multiply Mode: 
■ Keys: Alt, M, MT

Use Multiply to Create Copies of a Design
1 Load or draw a design.
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2 Select the design with Box Select , Point Line Select , or 
Freehand Select .

3 Drag the design upwards and to the left to move it a short distance 
from the center of the canvas.

4 Click the Multiply tab.
5 Click Enable Multiply . Your design is multiplied in a circle with four 

repeats. The reflected areas are marked by heavy horizontal and vertical 
blue lines.
The initial settings are Circle  and four Repeats, without Mirroring.

6 In the Multiply tab, click Horizontal . The three repeated designs are 
now either side of the original, and the blue Multiply lines run vertically.

7 In the Multiply tab, click Vertical .
The three repeated designs lie above and below the original, and the Multiply lines run 
horizontally.

8 In the Multiply tab, click Tile .
There are now 15 copies of your original design, forming a grid, with the original design 
within a blue outlined square.

9 If needed, move your original design within the blue square.
This blue square forms the original area that is multiplied.
You can use the Mirror and Size options to reflect the multiplied designs, and to set the 
size of the zone within the blue lines.

10 Click Apply Multiply  to place the multiplied designs on the canvas.

To go back to your original single design, click Undo  after using Apply Multiply.

Circle Options
The Circle Options enable you to set the number of repeats and reflect copies of the 
multiplied designs as facing pairs.

Repeats
Set the number of repeats for the multiplied circle of designs from 2 to 40. The initial 
number is 4.

Shortcuts
■ Keys: Alt, M, CR
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Mirror
Use Mirror  to reflect the designs to form pairs. Each alternate copy of the design is 
reflected. This generally looks best if the number of Repeats is an even number.

Shortcuts
■ Keys: Alt, M, CM

Alternative Mirror
Use Alternative Mirror  to reflect the designs with a rotated axis.

Shortcuts
■ Keys: Alt, M, CA

Use the Multiply Circle Options
1 Use New Window to start a new work area.
2 Load or draw a design.
3 Select the design with Box Select , Point Line Select , or 

Freehand Select .
4 Drag the design upwards and to the left to move it a short distance 

from the center of the canvas.
5 Click the Multiply tab.
6 Click Enable Multiply . Your design is multiplied in a circle with four 

repeats. The reflected areas are marked by heavy horizontal and vertical 
blue lines.
The initial settings are Circle  and four Repeats, without Mirroring.

7 In the Circle Options area, increase Repeats to 6.
There are now six blue Multiply lines.

8 Move your design so that it does not cross any of the blue Multiply lines.

Without Mirror With Mirror With Alternative Mirror
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9 In the Circle Options area, click Mirror .
Pairs of designs now face each other.

10 In the Circle Options area, click Alternative 
Mirror .
Some of your designs may now be badly overlapping.

11 Move your original design so that it is between two 
of the blue Multiply lines, and over the central grid 
line.
When using Mirror and Alternative Mirror, designs will 
overlap if they cross one of the blue Multiply lines.

12 Try using a different number of Repeats, and options 
with and without Mirroring.

13 Click Apply Multiply  to place the multiplied 
designs on the canvas.

Horizontal Options
The Horizontal Options enable you to set the number of repeats, set the Size of the 
Multiply zone, and reflect copies of the multiplied designs as facing pairs.

The initial settings use 4 Repeats and a Size of 25.0 mm in a 100 mm x 100 mm Canvas.

The Horizontal Options are used with the Horizontal and Tile Multiply Modes.

Repeats
Set the number of repeats for the horizontal line of designs from 2 to 40. The initial 
number is 4.

Shortcuts
■ Keys: Alt, M, RR

Size
Use Size to set the width of the Multiply zone from 10.0.mm to 1000.0 mm. in steps of 0.1 
mm. The initial Size is 25.0 mm.

Increase the Size to move the designs further apart. Decrease the Size to move the designs 
closer together, and to overlap the designs.

It is often desirable to adjust the Size until designs are touching or very close together when creating an 
embroidery, as this will reduce the number of movement stitches.

Shortcuts
■ Keys: Alt, M, RS

Mirror
Use Mirror  to reflect the designs to form pairs. Each alternate copy of the design is 
reflected.

Shortcuts
■ Keys: Alt, M, RM
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Use the Multiply Horizontal Options
1 In the View tab, ensure that the Canvas is set to 100mm x 100mm in size.
2 Load or draw a design.
3 Select the design with Box Select , Point Line Select , or Freehand Select .
4 Drag the design upwards and to the left to move it a short distance from the center of the canvas.
5 Click the Multiply tab.
6 In the Multiply tab, click Horizontal . 
7 Click Enable Multiply . Three repeated designs can be seen either side of the original. Blue 

Multiply lines run vertically.

The initial settings are 4 Repeats, with the Size of the Multiply zone set to 25.0mm.
8 Set Repeats to 5. At least one of your designs is outside the Canvas grid, and the central blue line may 

cross your design.

Pale blue lines mark out the other Multiply zones.
9 Set the Size to 20mm, so that the designs will fit within the Canvas grid.

Use Size to fit a design within a Multiply zone.
10 Ensure that your original design is between the two central heavy blue lines, then click Mirror .

The designs form facing pairs.

11 Move the central design to the right towards its reflected copy. The designs now overlap.

Vertical Options
The Vertical Options enable you to set the number of repeats, set the Size of the Multiply 
zone, and reflect copies of the multiplied designs as facing pairs.

The initial settings use 4 Repeats and a Size of 25.0 mm in a 100 mm x 100 mm Canvas.

The Vertical Options are used with the Vertical and Tile Multiply Modes.

Repeats
Set the number of repeats for the horizontal line of designs from 2 to 40. The initial 
number is 4.

Shortcuts
■ Keys: Alt, M, VR

Size
Use Size to set the width of the Multiply zone from 10.0.mm to 1000.0 mm. in steps of 0.1 
mm. The initial Size is 25.0 mm.

Increase the Size to move the designs further apart. Decrease the Size to move the designs 
closer together, and to overlap the designs.
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It is often desirable to adjust the Size until designs are touching or very close together when creating an 
embroidery, as this will reduce the number of movement stitches.

Shortcuts
■ Keys: Alt, M, VS

Mirror
Use Mirror  to reflect the designs to form pairs. Each alternate copy of the design is 
reflected.

Shortcuts
■ Keys: Alt, M, VM

Use the Multiply Vertical Options
1 In the View tab, ensure that the Canvas is set to 100mm x 100mm in size.
2 Load or draw a design.
3 Select the design with Box Select , Point Line Select , or Freehand Select .
4 Drag the design upwards and to the left to move it a short distance from the center of 

the canvas.
5 Click the Multiply tab.
6 In the Multiply tab, click Vertical .

The three repeated designs lie above and below the original, and the Multiply lines run 
horizontally.
The initial settings are 4 Repeats, with the Size of the Multiply zone set to 25.0mm.

7 Set the Size to 20mm, to reduce the size of the Multiply zone.
8 Click Mirror , half of your designs are now upside down!

Use Size to adjust the distance between your designs, and use Repeats to increase or 
decrease the number of designs.

9 In the Multiply mode section, click Tile .
Both the Horizontal and Vertical Options are now available.
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10 Increase both the Horizontal and Vertical number of Repeats 
to 5.
Your designs may show confusing overlapping.

11 Drag your original design into the center of the blue Multiply 
box.
If your design is larger than the box, there will still be some 
overlapping. 
Increase the Horizontal or Vertical Size to prevent overlapping.

12 Try using a different number of Repeats, and different settings 
for Size and Mirror with both the Horizontal and Vertical 
Options.

13 Click Apply Multiply  to place the multiplied designs on the 
canvas.
If you change to Circle  with a design in the center of the 
Canvas, all of the design copies will appear to collapse into the 
middle.
Drag your original design up and towards the left, and your designs will spread out around the circle.
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8Creating a Painting
A full range of painting functions is available for raster graphics files (created using a grid 
of pixels, and less easily resizable than vectors). In addition to the standard features, 
mySewnet™ Draw & Paint includes a range of Effects for improving pictures ready for 
creating designs.

Use the Paint tab and control panel to select and edit your picture.

Use the Paint window control panel to select colors, and paint lines and fill areas for your 
picture.

Cut, copy, paste or delete an area of the picture

Use a selection tool to choose part or all of the picture

Pick a color from the palette

Select a brush type and set its size and angle

Set the Tolerance for brushes, flood and selection tools

Paint with brush or line, or flood fill an area

Resize, crop, and fill the background to the picture

Choose a painting mode

Clone areas of the picture

Expand the width of outlines
Blur, lighten or darken part of the picture

Erase or flood erase parts of the picture

Pick a color from the picture

Change the intensity of the color

Rotate by 45 degrees, or remove red-eye effect from photos

Line editing tools
Color and light Effects
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Mode
Choose a mode for editing your picture:

• Soft Edges  are used when editing photographs, paintings or pictures for 
PhotoStitch. The Tools give a softer (anti-aliased) edge with gradients and semi-
transparencies.

• Hard Edges  are used when editing and cleaning clipart for designing over, such as 
when using the Express Design Wizard or digitizing in the Create windows. The Tools 
will give a pixelated edge.

Select a Mode from the drop-down menu before starting work.

Some tools are not available in both modes, for example Expander  cannot be used with Soft 

Edges , and Blur  cannot be used with Hard Edges .

Soft Edges
Soft Edges  are typically used when editing photographs, paintings or pictures for 
PhotoStitch. The Tools give a softer (anti-aliased) edge with gradients and semi-
transparencies.

To see the effect of using Soft Edges , draw a thick line in a dark color with the Paintbrush , using the 
Brush type Very Soft Circle.

Shortcut

■ Paint Window Control Panel, Mode: 

Hard Edges
Hard Edges  are typically used when editing and cleaning clipart for designing over, 
such as when using the Express Design Wizard or digitizing in the Create windows. The 
Tools give a pixelated edge. 

Tools such as Blur, Highlight and Lowlight that would create a gradient or semi-transparency are grayed 
out.

Shortcut

■ Paint Window Control Panel, Mode: 

Choose Painting Colors
Color Box and Color Palette
Use the Color box and Color palette to choose 
the colors for painting.

The Color palette provides 40 commonly used 
colors. Click on a color in the palette to place it in 
the Design Panel.

Change the Color

See more colors

Select a color
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The Colors area in the Design Panel displays the currently selected color.

For information on selecting additional colors, see “Colors Dialog Box” on page 29.

Change a Color in the Colors Area
■ Click the drop-down menu for colors, then click on a color from the Color palette to select 

it.
■ To choose a color that is not in the Color palette, click More Colors in the palette to bring 

up the Colors dialog box. (After a color is chosen, it will be placed as the color.)

■ To select a color from the picture on the screen use Pick Color  in the Paint panel.

Pick Color
Use Pick Color  to select a color from the picture on the screen and make it color in the 
Color box.

This is useful for choosing colors from the picture for drawing that do not appear in the 
Color palette.

Shortcut

■ Paint Window Control Panel, Color / Intensity: 

Intensity
Intensity  controls the intensity of the tool you are using. Drag the slider or change the numbers 
to alter the Intensity.

For example, Paintbrush  paints in full color using 100%, but is faded at lower values; at 1% it is barely 
visible, but will show if you constantly paint over the same area.
Intensity is initially set to 100%.

Tools
Paintbrush
Use the Paintbrush  to paint lines on the picture that follow the movement of the 
pointer. Choose one of the Brush Shapes, and set its Size and Angle. See “Brush Types” on 
page 86.

Shortcut
■ Paint Window Control Panel, Tools: 

Draw a Line with the Paintbrush
1 Select the desired color in the Color panel. Use Pick Color  if you want to select a color from the 

picture.
2 Click the Paintbrush icon .
3 Change the line width and style if desired by selecting a Brush Shape, Size and Angle.
4 Click and drag across the work area from the desired start point to the desired end point to draw a 

line. A line appears showing the freehand line as it is drawn. Lift the pen or release the mouse button 
and the line is completed. 

5 Each time you drag and release a new line will be drawn, until another feature is selected.
You can single-click to place dots of color.
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Line
Use Line  to draw straight lines in the picture. Set the width of the line with Size  in 
the Brush section. See “Size” on page 86.

Shortcut
■ Paint Window Control Panel, Tools: 

Draw Straight Lines with the Line Tool
1 Select the desired colors for foreground and background in the Color panel. Use Pick Color  if you 

want to select colors from the picture.
2 Click the Line icon .
3 Change the line width if desired by selecting a line width in Size  in the Brush section.
4 Click and drag across the work area from the desired start point to the desired end point to draw a 

line. A line appears "attached" to the pointer showing the size of the line that will be drawn. The 
length of the line in pixels is shown in the status bar. 

5 Lift the pen or release the mouse button and the line is drawn in the foreground color.
6 Each time you drag and release a new line will be drawn, until another feature is selected.

Flood Fill
Use Flood Fill  to fill an area of the picture with the selected color. The pointer changes 
to the paint bucket . The area to be filled is defined by other colors surrounding it or the 
edges of the work area. Click to fill an area using the selected color. Flood fill will not flow 
across gaps between separate areas of the same color. Either fill each area separately, or 
use other drawing tools to 'patch up' a shape to make it a continuous area of the same 
color.

Shortcut
■ Paint Window Control Panel, Tools: 

Flood Fill an Area
1 Select the desired color in the Color panel. Use Pick Color  if you want to select colors from the 

picture.
2 Click the Fill icon  and the pointer changes to the paint bucket .
3 Change the color sensitivity of Flood Fill with Tolerance , by adjusting the slider.

See “Tolerance” on page 86.
4 Click on a color within your picture. Adjacent areas in the picture with a similar color to the area that 

you clicked are filled with the foreground color (or the background color, if you right-click).
5 Flood Fill is enabled until another tool is activated, or you right-click to deselect it.

Blur
Not available with Hard Edges.
Use Blur  to blur the area under the brush.

Blur has soft edges. The pixels closer to the center of the brush are affected more than those around the 
edge.

Shortcut
■ Paint Window Control Panel; Tools: 
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Blur an Area of the Picture
1 Click the Blur icon .
2 Change the line width and style if desired by selecting a Brush Shape, Size and Angle.

See “Brush Types” on page 86.
3 Click and drag across the work area from the desired start point to the desired end point. The detail in 

that part of the picture is slightly blurred. Lift the pen or release the mouse button to complete the 
action. Each time you drag and release a new area will be affected, until another feature is selected.

Highlight
Not available with Hard Edges.
Use Highlight  to increase the lightness of an area of the picture, and make it more 
prominent.

Highlight has soft edges.The pixels closer to the center of the brush are affected more than those around 
the edge.

Shortcut
■ Paint Window Control Panel; Tools: 

Highlight an Area of the Picture
1 Click the Highlight icon .
2 Change the line width and style if desired by selecting a Brush Shape, Size and Angle.

See “Brush Types” on page 86.
3 Click and drag across the work area from the desired start point to the desired end point. That part of 

the picture will be highlighted (brightened). Lift the pen or release the mouse button to complete the 
action. Each time you drag and release a new area will be affected, until another feature is selected.

Lowlight
Not available with Hard Edges.
Use Lowlight  to decrease the lightness of an area of the picture, and make it less 
prominent.

Lowlight has soft edges.The pixels closer to the center of the brush are affected more than those around the 
edge.

Shortcut
■ Paint Window Control Panel; Tools: 

Lowlight an Area of the Picture
1 Click the Lowlight icon .
2 Change the line width and style if desired by selecting a Brush Shape, Size and Angle.

See “Brush Types” on page 86.
3 Click and drag across the work area from the desired start point to the desired end point. That part of 

the picture is made darker, by removing brightness from it. 
4 Lift the pen or release the mouse button to complete the action. Each time you drag and release a 

new area will be affected, until another feature is selected.

Erase Tools
Use the erase tools to remove part of the picture, leaving a transparent area.
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Erase
Use Erase  to erase areas of the picture. The pointer changes to the Erase pointer . 
Choose one of the Brush Shapes for the eraser, and set its Size and Angle. See “Brush 
Types” on page 86.

To remove a large area of the picture, select the area then Delete  or Cut  the area. Alternatively, use 

Flood Erase .

Shortcut
■ Paint Window Control Panel; Tools: 

Erase Part of the Picture
1 Click the Erase icon . The pointer changes to the eraser pointer .
2 Change the style and width if desired by selecting a Brush Shape, Size and Angle.
3 Click and drag across the work area to erase an area. Whenever the cursor passes over a pixel that is 

not transparent, it changes it to transparent. 
4 Each time you click and drag, areas will be erased, until another feature is selected. Also use single 

clicks to erase dots.

Flood Erase
Use Flood Erase  to fill areas of the picture to make them transparent. The pointer 
changes to the Flood Erase pointer . The area to be filled is defined by other colors 
surrounding it or the edges of the work area. Click to fill an area. 

Flood Erase will not flow across gaps between separate areas of the same color. Either fill 
each area separately, or use other drawing tools to 'patch up' a shape to make it a 
continuous area of the same color.

Use the Tolerance  settings to select the color variation for the area to be erased. See 
“Tolerance” on page 86.

Shortcut
■ Paint Window Control Panel; Tools: 

Remove a Background with Flood Erase
1 Click the Flood Erase icon  and the pointer changes to the Flood Erase pointer .
2 Change the color sensitivity of Flood Erase with Tolerance , by adjusting the slider.

See “Tolerance” on page 86.
3 Click on a color within your picture. Adjacent areas in the picture with a similar color to the area that 

you clicked are erased.

Clone
Use the Clone  tool to copy a color and texture from one part of a picture to another. 
The Clone tool is useful for editing out unwanted features in a photo, or stamping a motif 
on part of an image.
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Right-click and select Reset Origin from the context menu, or press the Ctrl key, to reset 
the origin point when cloning.

Use Persistent Offset for Clone Tool in Preferences to change the behavior of the origin 
point. See “Persistent Offset for Clone Tool” on page 110.

When set, the origin moves with the pointer when lifted. Otherwise, the origin point reverts to its original 
position each time the pointer is lifted.

Shortcut
■ Paint Window Control Panel; Tools: 

Using the Clone Tool
1 Load a photo or picture for editing.
2 Choose the brush size.

A small brush will take longer, but help with detail.
3 Choose the type of brush for copying.

Clone is most easily used at 100% Intensity, and with a solid edged brush such as Circle. 
For a smooth shading between copied and original areas, use a soft brush such as Soft Circle, or a lower 
Intensity.

4 Click the Clone  tool, and move over the Canvas. The crosshairs pointer  can be seen.
5 Move the pointer over the area that you want to copy from.
6 Click the area to be copied.

The Clone pointer appears .
7 Move over the area that you want to cover with the copied color and texture.
8 Paint the area with the borrowed color.

Use a single click with Clone to stamp an area, or paint with Clone to mask unwanted areas in a photo.
9 Lift the pointer frequently if copying large areas.

The copied area is refreshed each time the pointer is lifted, so lift frequently when copying cloned areas.
10 Right-click and select Reset Origin Point from the context menu to use the crosshairs pointer to select 

a new area to copy from.
Alternatively, press Ctrl to reset the origin.

Expander
Not available with Soft Edges.
Expander  increases the width of lines or areas in the picture.

Shortcut
■ Paint Window Control Panel; Tools: 

Place the origin pointer Remove unwanted details
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Expand the Width of Lines in a Picture
1 Click the Expander  icon. The Expander pointer  appears.
2 Zoom in on a line that you want to expand.
3 Click on the line to expand it. All lines using that color in the picture will be expanded.

Click again to expand the lines further.

Brush Types
Choose a Brush Shape, then set a Size and Angle for your painting tool.

Select Calligraphy and use a slight Angle for writing a greeting.

Brush Shape
Choose a Brush shape for painting with. 

A greater range of brush shapes is available with Soft Edges mode. See “Mode” on 
page 80.

Size
Use Size  to set the width of your brush stroke. Use the slider or change the numbers to change 
the size.

Size can be set from 1 to 100.

Angle
Use Angle  to set the angle of your brush. Use the slider or change the numbers to change the 

angle.

Use Calligraphy at a slight Angle for writing.
Angle can be set from 1 to 180 degrees.

Tolerance
Use Tolerance  to adjust the number of shades of a color that are selected when using a tool such 
as Flood Fill  or Magic Wand . A higher tolerance increases the range of color shades that are 
selected, and a lower tolerance reduces the range of shades. 

A Tolerance value of 0 will select only pixels that exactly match, whereas a value of 255 will select all pixels.

Brushes for use with Soft Edges Brushes for use with Hard Edges
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Drag the Tolerance  slider to choose the range of color shades that will be selected with 
Tolerance.

Tolerance can be used with: Flood Fill , Flood Erase  and Magic Wand .
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9Editing Paintings
Use one of the selection tools: Box Select , Freehand Select , Freehand Point 
Select , Ellipse Select , or Magic Wand Select  to select part of the picture as a 
block. 

After selection, delete, cut, copy, resize, rotate 
or mirror the selection. Crop the picture so that 
only the selected area remains. Apply effects to 
enhance or adjust only the selected area. 

For more information on selecting, modifying 
copying and cutting, see “Select, Modify & 
Copy” on page 14.

Resize Part of a Picture
When part of the picture has been selected with one of the selection tools, click and drag 
one of the corner resize handles to change the size of the area. When the pointer is over a 
resize handle the pointer changes to a double-headed arrow pointer . 

Hold the Shift key down when resizing to keep the proportions the same. Hold the Ctrl key 
down to resize from the center. With selection tools other than Box Select, only the area 
that was selected is resized, even though the selection box appears rectangular.

If no part of the picture is selected, use the Scale Image  function to change the size of the whole 
picture. See “Scale Image” on page 89.

Rotate Part of the Picture
Rotate part of the picture using the Rotate Handle on the selection box.

To rotate part or all of the picture by exactly 90 degrees, use Rotate 45 .

Rotate Part of a Picture
1 Select part of the picture using one of the selection tools.
2 Click and drag the round rotate handle on the selection box to Rotate the area to any degree.

When an area is chosen with one of the selection tools, only the area that was selected is rotated, even if 
the selection box appears rectangular.

Rotate 45
Use Rotate 45  to rotate the selected part of the picture by 45 degrees. 

When an area is chosen with one of the selection tools, only the area that was selected is rotated, even if 
the selection box appears rectangular.

Rotate 45  is unavailable if there is no selection.

Shortcuts
■ Paint Window Control Panel, Edit: 
■ Keys: Alt, D, 9

Resize
Handle

Rotate
Handle

Selection
Box

Center of Rotation Skew Handle
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Remove Red-eye
Use Remove Red-eye  to reverse the red-eye effect caused when flash is reflected back 
by the retina of the eye.

Remove Red-eye can also be used to remove other intrusive reds, such as red lights.

Remove the Red Eye Effect from a Photo
1 If desired, use Zoom To Rectangle  to magnify the affected area.
2 Use Ellipse Select  to draw an ellipse around the affected eye.

If desired, use Add to Selection  and select the other eye at the same time. See “Add To Selection” on 
page 20.

3 Click Remove Red-eye . Any bright red in that part of the picture has a blue cast added to it, to 
counteract the red effect.

If you make a mistake, use Undo  to reverse red-eye removal, then try again.
4 Check the result in the work area.

Shortcuts
■ Paint Window Control Panel; Edit: 
■ Keys: Alt, P, D

Adjust the Canvas and Picture
Scale Image 
Use Scale Image  to increase or 
decrease the size of the whole picture 
on the Canvas. The Resize dialog box 
appears so you can enter a new 
picture size.

The Scale Image function only resizes the 
whole picture, any selection within the picture is ignored. To resize part of the picture, use the resize 
handles to resize that selection. See “Select a Block” on page 14. 
When the picture is resized it is automatically resampled. For example, if the picture size is 
increased, the resampling process interpolates (adds) pixels until the desired size is 
reached, matching the colors used to those already used in the picture. This produces a 
more pleasing result than if the pixels were simply expanded in size, which would produce 
a 'blocky' effect. However, it should be realized that whenever a picture is resized, some 
change occurs compared with the original.

A picture may be resized up to a maximum of 2000 pixels in each dimension.

Shortcuts
■ Paint Window Control Panel, Edit: 
■ Keys: Alt, D, I
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Resize a Picture
1 In the Canvas drop-down menu, click Scale Image . The Resize dialog box will appear.
2 Move the slider bar until the desired width or height is shown, or type in the desired figure. The 

percentage related to the original picture is shown in the box to the right. For example if the width is 
increased from 1000 pixels to 1100, the Percentage of Original Width would be shown as 110%.

3 If the Proportional option is selected, the slider bars will move together to keep the Height and Width 
in proportion. Deselect Proportional to change the Height and Width separately.

4 Click OK when the desired size is shown. The picture will be resized.

Crop to Selection
Use Crop to Selection  to decrease the size of the picture by removing the parts that are 
not wanted. Use one of the selection tools, e.g. Box Select  or Freehand Select , to 
select the area of the picture that you wish to keep, then in the Canvas drop-down menu, 
select Crop to Selection . The parts of the picture outside the selection box are removed 
and the display adjusts to show the remaining part of the picture at the largest possible 
magnification.

Crop to Selection is unavailable if there is no selection. Crop to Selection only removes rectangular areas of 

the picture, therefore the results will be the same whether you select the area using Box Select  or 

Freehand Select .

Shortcuts
■ Paint Window Control Panel, Edit: 
■ Keys: Alt, D, P

Rotate Canvas
Use Rotate Canvas  to rotate the whole 
picture by any degree. The Rotate dialog box 
appears so you can enter the rotation angle. 

The Rotate function only rotates the whole picture, so 
any selection within the picture is ignored. To rotate part 
of the picture, use the rotate handle on the selection box 
to rotate the selection. See “Rotate Part of the Picture” on 
page 88. 
To rotate part or all of the picture by exactly 45 degrees, 

use Rotate 45 .

When an area is chosen with one of the selection tools, 
only the area that was selected is rotated, even if the 
selection box appears rectangular.

Shortcuts
■ Paint Window Control Panel, Edit: 
■ Keys: Alt, D, R

Rotate a Picture
1 Ensure that no part of the picture is selected.

Any selection will be ignored.
2 In the Canvas drop-down menu, click Rotate Canvas  and the Rotate dialog box will appear.
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3 Use the up and down arrows to select the desired angle of rotation, or enter the desired figure.
4 When the rotation is as desired, click OK. The picture will be rotated and, if necessary, resized.

Perspective Correction
To remove the effects of perspective in a picture, or to correct skew, select Perspective 
Correction . When using Perspective Correction, the crop handles are red.

Move the red handles so that the crop lines frame the picture. Use the Zoom tools to view 
the outline of the picture more clearly. Drag the Stretch Picture  slider to make the 
picture in the Preview wider or narrower.

Shortcuts
■ Paint Window Control Panel, Edit: 
■ Keys: Alt, D, R

Expand to Match Canvas
Use Expand to Match Canvas  to resize the contents of the Paint canvas so that it fits the 
width of the Draw Canvas. 

The picture on the screen is not resized. Any area that is added around the edge of the 
picture is added as a Transparent area.

To resize the picture itself, or part of the picture, select and resize the block. See “Resize Part of a Picture” on 
page 88.

Shortcuts
■ Paint Window Control Panel, Edit: 
■ Keys: Alt, D, R
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Fill Transparent
Use Fill Transparent  to fill any transparent areas of the canvas with the selected color.

Fill the Background to a Picture
1 Use Pick Color  to select the background color from the picture on the screen.

This selects the color that you will fill with.
2 In the Canvas drop-down menu, click Fill Transparent .
3 Any transparent areas around the picture, or within the picture, will be filled with your selected color.

Shortcuts
■ Paint Window Control Panel, Edit: 
■ Keys: Alt, D, R
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Line Finder
The Line Finder  tools are:

• Find Center Line
• Find Outline

The Line Finder tools are only available when Hard Edges  is enabled. See “Hard Edges” on page 80.

Shortcuts
■ Paint Window Control Panel, Line Finder 
■ Keys: Alt, D, E, N

Find Center Line
Use Find Center Line to reduce the thickness of the selected color area to one pixel only, or 
to the selected thickness (up to 5 pixels). The new outline will be halfway between the 
adjoining color areas, as they are widened to allow the selected color to be narrowed. The 
function works on any continuous color area within the picture, but it is most often used 
to thin an outline so that there are smaller gaps between areas of the picture. This can 
produce a more pleasing picture. 

The thinning process produces a thinner outline that is more suitable for the QuickStitch™ features in 
mySewnet™ Digitizing.

Reduce the Thickness of an Outline
1 Click Open  and open ThinEg.bmp from Documents\mySewnet\Samples\Digitizing\Pics. 

The black outline around the flower is relatively thick and looks unnatural. Use the Find Center Line to 
make the black area narrower.

2 Click Line Finder  in the Paint window Control Panel, and the Line Finder dialog is displayed.
If you do not select a line color with Pick Color, the current line color will be used. If this color is not used in 
the picture, the Find Center Line will have no effect.

3 Click to select Find Center Line.
4 Use Pick Line Color  in the Find Center Line area to select the desired line color from the picture.
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Be careful where you click when using Pick Line Color. The color you click on is the color that will be 
thinned. If you click on a fill area, this area will be thinned and the outline around it will be thickened to 
compensate. If the changes are not as desired, click Cancel and try again.

5 Click the thick black outline color in the picture.
6 In the preview pane the picture is redrawn with the thickness of the black outline reduced to one 

pixel. The green and yellow areas have become wider, as has the blue background. The new black 
outline runs through the center of the old one.

7 When the picture in the preview window at the right appears as desired, click OK.
The Find Center Line tool may not work if your picture has dithering, for example a scanned image or one 
that has been converted from a JPEG file.
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Find Outline
Find Outline finds the outlines around color areas in the picture. This may turn solid lines 
in the picture into paired outlines. The color of the original area is used for the outline, and 
the area inside each outline is filled with the background color.

Find the Outline in a Picture
1 Click Line Finder  in the Paint window Control Panel, and the Line Finder dialog is displayed.
2 Click to select Find Outline.

A Background Color is automatically selected from the picture, and in the preview pane, color areas in the 
picture are turned into outlines.

3 If desired, use Pick Background Color  in the Find Outline area to select a different background 
color from the picture.

4 When the picture in the preview window at the right appears as desired, click OK.

Zoom
Use the Zoom functions to change the view of the picture.

Use Zoom In  to magnify the view. Move the pointer over the picture and the pointer 
changes to the zoom in pointer . Then either click a point you want to zoom in towards, 
or click and drag a rectangle around the area you want to zoom in to and release the 
mouse button to zoom. When zoomed in, use the scroll bars to move around.

Use Zoom Out  to shrink the view. Move the pointer over the picture and the pointer 
changes to the zoom out pointer . Then click a point you want to zoom out from.

Click Zoom To Fit  to fit the picture to the preview area.

Click Real Size  to view the picture at its real size in pixels. This means that one pixel of 
the picture uses one pixel of the screen.
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10Using Effects
Use the Effects  dialog in the Paint tab control panel to change and enhance the 
picture; for instance, to make certain features stand out or improve the color 
representation of the picture. Effects act on all, or the selected part, of the picture.

Effects

The effect types are:

■ Brightness 
■ Contrast 
■ Gamma 
■ Autolevel 
■ Auto-contrast 
■ Negative 
■ Saturation 
■ Hue 
■ Grayscale 
■ Sepia 
■ Colorize 
■ Color Filter 
■ Inverse Color Filter 
■ Blur 
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■ Sharpen 
■ Despeckle 
■ Monochrome 
■ Reduce Colors 

Zoom
Use the Zoom functions to change the view of the picture.

Use Zoom In  to magnify the view. Move the pointer over the picture and the pointer 
changes to the zoom in pointer . Then either click a point you want to zoom in towards, 
or click and drag a rectangle around the area you want to zoom in to and release the 
mouse button to zoom. When zoomed in, use the scroll bars to move around.

Use Zoom Out  to shrink the view. Move the pointer over the picture and the pointer 
changes to the zoom out pointer . Then click a point you want to zoom out from.

Click Zoom To Fit  to fit the picture to the preview area.

Click Real Size  to view the picture at its real size in pixels. This means that one pixel of 
the picture uses one pixel of the screen.

Undo
Reset the picture back to the original settings.

Shortcuts
■ Paint Window Control Panel, Edit: 
■ Keys: Alt, D, E, L

Select an Effect
1 Click Effects  in the Paint tab control panel.
2 In the Effects dialog box, click the drop-down arrow and a list of effects appears.
3 Click the desired effect type. The effect dialog box opens.
4 Adjust the effects until the Preview window at the right appears as desired.
5 Click OK and the effects will be applied.

Brightness
The Brightness  effect makes the selected part or all of a picture lighter or darker than 
the original. Use it to lighten pictures that are too dark.

Adjust Brightness from -255 (Dark) to +255 (Light) in steps of 1. The initial setting is 0.

Adjust Brightness for the whole picture, or use Box Select or another selection tool to choose an area of the 
picture to change.

Change the Brightness of a Picture
1 Click Effects  in the Paint tab control panel.
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2 In the Effects dialog box, click the drop-down arrow and select Brightness .
3 Adjust the Brightness between -255 and +255 relative to the starting point by typing in a number, 

using the left and right arrow keys, or by clicking and dragging the slider bar. To brighten the picture, 
move the slider to the right, use the right arrow key, or type a positive number in the box. To darken 
the picture, move the slider to the left, use the left arrow key, or type a negative number in the box.

4 When the picture in the preview window at the right appears as desired, click OK.
Click Undo to start again.

Contrast
The Contrast  effect changes the amount of shading between areas for the selected 
part or all of a picture. Use it to make specific areas stand out. Adjust Contrast up to +10 or 
-10 more or less than the original. Increasing the setting will increase the darkness of dark 
areas and the lightness of light areas.

Adjust Contrast from -10 to +10 in steps of 0.1. The initial setting is 0.

Adjust Contrast for the whole picture, or use Box Select or another select tool to choose an area of the 
picture to change.

Change the Contrast in a Picture
1 Click Effects  in the Paint tab control panel.
2 In the Effects dialog box, click the drop-down arrow and select Contrast .
3 Adjust the Contrast between -100 (Low) and +100 (High) relative to the starting point by typing in a 

number, using the left and right arrow keys, or by clicking and dragging the slider bar. To increase, 
move the slider to the right, use the right arrow key, or type a positive number in the box. To decrease, 
move the slider to the left, use the left arrow key, or type a negative number in the box.

4 When the picture in the preview window at the right appears as desired, click OK.
Click Undo to start again.

Gamma
Use Gamma  to adjust the brightness and contrast together so that dark areas are made 
brighter, but bright areas are not overexposed.

Adjust Gamma from 0.2 (Light) to 4 (Dark) in steps of 0.1. The initial setting is 1. Lower 
values will make the picture appear lighter.

Adjust Gamma for the whole picture, or use Box Select or another select tool to choose an area of the 
picture to change.

Adjust the Gamma in a Picture
1 Click Effects  in the Paint tab control panel.
2 In the Effects dialog box, click the drop-down arrow and select Gamma .
3 Adjust the Gamma between 2 and 40 by typing in a number, using the left and right arrow keys, or by 

clicking and dragging the slider bar. To increase, move the slider to the right, use the right arrow key, 
or type a positive number in the box. To decrease, move the slider to the left, use the left arrow key, or 
type a negative number in the box.

4 When the picture in the preview window at the right appears as desired, click OK.
Click Undo to start again.

Autolevel
Use Autolevel  to adjust brightness and contrast in the picture automatically. Autolevel 
improves brightness and contrast in most pictures, and can be used to bring out the color 
in underexposed pictures.
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Use the slider to change the degree of Autolevel. Autolevel is set at 100% initially.

Occasionally Autolevel does not improve the appearance of a picture, and may need to be switched off.

Auto-contrast
Use Auto-contrast  to adjust the contrast between the bright and dark areas in the 
picture automatically, while retaining the detail. It can be used to sharpen a hazy picture.

Use the slider to change the degree of Auto-contrast. Auto-contrast is set at 100% initially.

Negative
Use Negative  to invert the luminosity of the picture, so that bright areas appear dark, 
and dark areas bright.

Use the slider to change the amount of inversion of the colors. Negative is set at 100% 
initially.

Saturation
The Saturation  effect changes the amount of gray in the selected part or all of a picture. 
Adjust Saturation between -100 (Gray) and +100 (Bright). 

Increasing the setting enhances the intensity of colors in a picture, for instance, to make 
pale skin tones appear 'warmer'.

Adjust Saturation from -100 (Gray) to +100 (Bright) in steps of 1. The initial setting is 0.

Adjust Saturation for the whole picture, or use Box Select or another select tool to choose an area of the 
picture to change. To turn part or all of a picture completely gray and create a grayscale effect, set 
saturation to -10.

Change the Saturation in a Picture
1 Click Effects  in the Paint tab control panel.
2 In the Effects dialog box, click the drop-down arrow and select Saturation .
3 Adjust the Saturation between -100 (completely gray) and +100 relative to the starting point by 

typing in a number, using the left and right arrow keys, or by clicking and dragging the slider bar. To 
increase, move the slider to the right, use the right arrow key, or type a positive number in the box. To 
decrease, move the slider to the left, use the left arrow key, or type a negative number in the box.

4 When the picture in the preview window at the right appears as desired, click OK.
Click Undo to start again.

Hue
The Hue  effect changes the shades of the colors in the picture. Adjust the Hue between 
-180 and +180.

This effect makes colors change as if rotated around a color wheel. A small adjustment can make 
considerable changes to the color of a picture.
Adjust Hue from -180 to +180 in steps of 1. The initial setting is 0.

Adjust Hue for the whole picture, or use Box Select or another select tool to choose an area of the picture to 
change. To tint a picture with a specific color, use a Color Filter.

Change the Hue in a Picture
1 Click Effects  in the Paint tab control panel.
2 In the Effects dialog box, click the drop-down arrow and select Hue .
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3 Adjust the Hue between -180 and +180 relative to the starting point by typing in a number, using the 
left and right arrow keys, or by clicking and dragging the slider bar. To increase, move the slider to the 
right, use the right arrow key, or type a positive number in the box. To decrease, move the slider to the 
left, use the left arrow key, or type a negative number in the box.

4 When the picture in the preview window at the right appears as desired, click OK.
Click Undo to start again.

Grayscale
The Grayscale  effect changes all of the color shades in the picture to shades of gray. 
Adjust Grayscale between 0% and 100% in steps of 1. The initial setting is 100%.

Adjust Grayscale for the whole picture, or use Box Select or another select tool to choose an area of the 
picture to change.

Sepia
The Sepia  effect changes all of the color shades in the picture to shades of sepia 
(reddish-brown). Adjust the Sepia effect between 0% and 100% in steps of 1. The initial 
setting is 100%.

Adjust Sepia for the whole picture, or use Box Select or another select tool to choose an area of the picture 
to change.

Colorize
The Colorize  effect applies a single color to the picture at varying intensities. Use the 
upper slider to colorize with the selected color as from a color wheel, and the lower slider 
to fade the effect.

This effect makes colors change as if rotated around a color wheel.
The upper slider adjusts the color from 0 (Red) to 360 (Violet) in steps of 1 via orange, 
yellow, green and blue. The initial setting is 0 (Red).

The lower slider fades the effect from 100% (fully colorized) to 0% (original colors). The 
initial setting is 100%.

Color Filter
Use Color Filter  to tint the picture using the selected color and intensity. Only the light 
from the selected color passes through.

This effect makes colors change as if rotated around a color wheel.
The upper slider adjusts the color from 0 (Red) to 360 (Violet) in steps of 1 via green and 
blue. The initial setting is 0 (Red).

The lower slider sets the intensity of the color tint. 100% uses only the shades of the 
selected filter color, and 0% is no tint. The initial setting is 100% (fully tinted).

Use Color Filter for the whole picture, or use Box Select or another select tool to choose an area of the 
picture to change.

Use a Color Filter
1 Click Effects  in the Paint tab control panel.
2 In the Effects dialog box, click the drop-down arrow and select Color Filter .
3 Adjust the color for the filter (upper slider) between 0 and 360 typing in a number, using the left and 

right arrow keys, or by clicking and dragging the slider bar.
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4 Adjust the color tint (lower slider) between 0% (no tint) and 100% (your selected color) relative to the 
starting point by typing in a number, using the left and right arrow keys, or by clicking and dragging 
the slider bar.

5 When the picture in the preview window at the right appears as desired, click OK.

Inverse Color Filter
Use Inverse Color Filter  to tint the picture in the opposite way to a physical filter using 
the selected color and intensity. Only the light from the selected color is removed.

This effect makes colors change as if rotated around a color wheel.
The upper slider adjusts the color from 0 (Red) to 360 (Violet) in steps of 1 via orange, 
yellow, green and blue. The initial setting is 0 (Red).

The lower slider sets the intensity of the color tint. 100% uses only the shades of the 
selected filter color, and 0% is no tint. The initial setting is 100% (fully tinted).

Use Inverse Color Filter for the whole picture, or use Box Select or another select tool to choose an area of 
the picture to change.

Use Inverse Color Filter
1 Click Effects  in the Paint tab control panel.
2 In the Effects dialog box, click the drop-down arrow and select Inverse Color Filter .
3 Adjust the color for the filter (upper slider) between 0 and 360 typing in a number, using the left and 

right arrow keys, or by clicking and dragging the slider bar.
4 Adjust the color tint (lower slider) between 0% (no tint) and 100% (your selected color) relative to the 

starting point by typing in a number, using the left and right arrow keys, or by clicking and dragging 
the slider bar.

5 When the picture in the preview window at the right appears as desired, click OK.

Blur
Use Blur  to blur the edges between differently colored areas in the picture, by 
smoothing the contrast between pixels adjacent to defined lines and shaded areas. Use 
the Blur effect to change the focus of a picture, or to remove unwanted detail from part of 
a picture.

Adjust Blur for the whole picture, or use Box Select or another selection tool to choose an area of the 
picture to change.
The upper slider adjusts Blur between 0 (Soft) and 3 (Strong) in steps of 1. The initial 
setting is 0.

The lower slider sets the intensity of the blurring from 0% to 100%. The initial setting is 
100%.

Blur a Picture
1 Click Effects  in the Paint tab control panel.
2 In the Effects dialog box, click the drop-down arrow and select Blur .
3 Adjust the amount of blurring between0 and 3 by typing in a number, using the left and right arrow 

keys, or by clicking and dragging the slider bar.
4 Adjust the intensity between 0% (no blurring) and 100% (full effect) by typing in a number, using the 

left and right arrow keys, or by clicking and dragging the slider bar.
5 When the picture in the preview window at the right appears as desired, click OK.
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Sharpen
Use Sharpen  to enhance the edges between differently colored areas in the picture, by 
increasing the contrast between pixels adjacent to defined lines and shaded areas. Use the 
Sharpen effect to change the focus of a picture, or to enhance detail in part of a picture.

Adjust sharpness for the whole picture, or use Box Select or another selection tool to choose an area of the 
picture to change.
The upper slider adjusts Sharpen between 0 (Soft) and 100 (Strong) in steps of 1. The initial 
setting is 0.

The lower slider sets the intensity of the sharpening from 0% to 100%. The initial setting is 
100%.

Sharpen a Picture
1 Click Effects  in the Paint tab control panel.
2 In the Effects dialog box, click the drop-down arrow and select Sharpen .
3 Adjust the Sharpness between 0 and 100 by typing in a number, using the left and right arrow keys, or 

by clicking and dragging the slider bar.
4 Adjust the intensity between 0% (no sharpening) and 100% (full effect) by typing in a number, using 

the left and right arrow keys, or by clicking and dragging the slider bar.
5 When the picture in the preview window at the right appears as desired, click OK.

Despeckle
Despeckle  removes small spots from the picture anywhere between 1 and 100 pixels in 
size. The initial setting is 1 pixel.

It is useful for pictures that have been scanned.

Despeckle a Picture
1 Click Effects  in the Paint tab control panel.
2 In the Effects dialog box, click the drop-down arrow and select Despeckle .
3 Either use the up and down arrows, or enter a number representing the size in pixels of the largest 

spot(s) to be removed. The preview on the right shows the despeckled version.
If some of the detail that you wish to use to create your embroidery has been removed, click Undo. Then try 
again using a a smaller number.

4 When the picture in the preview window at the right appears as desired, click OK.

Monochrome
The Monochrome effect  turns all shades or colors in the selected part or all of a picture 
into either black or white. It acts on the whole picture, or a selected area. The 
Monochrome effect is useful to create defined color areas that you can then color with the 
painting tools for artistic effects.

Adjust Monochrome between 0 and 254 in steps of 1. The initial setting is 254.

Use Monochrome on the whole picture, or use a selection tool to choose an area of the picture to change.

Change a Picture to Monochrome
1 Click Effects  in the Paint tab control panel.
2 In the Effects dialog box, click the drop-down arrow and select Monochrome .
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3 Adjust the Monochrome Threshold between 0 and 254 by typing in a number, using the left and right 
arrow keys, or by clicking and dragging the slider bar. To make more of the picture black, move the 
slider to the right, use the right arrow key, or type a higher number in the box. To make more of the 
picture white, move the slider to the left, use the left arrow key, or type a lower number in the box. 

4 When the picture in the preview window at the right appears as desired, click OK.

Reduce Colors
Use Reduce Colors  to reduce the number of colors in the picture, matching each pixel 
to a limited palette. It acts on the whole picture, or a selected area.

Use Reduce Colors to reduce the number of colors in the picture, for example to 'flatten' some complex 
areas of color, which can make the picture easier to use with the QuickStitch™ and QuickTrace features in 
mySewnet™ Digitizing.
Reduce Colors determines the optimal number of colors for the picture. This optimal 
number is given as the recommended number of colors, out of the total number of colors.

The total number of colors is the number of colors in the picture, or 255 if more than 255 colors are present.

Reduce the Number of Colors in a Picture
1 Click Effects  in the Paint tab control panel.
2 In the Effects dialog box, click the drop-down arrow and select Reduce Colors .

The Reduce Colors window appears, with the slider set at the recommended number of colors.
3 Adjust the number of colors between 0 and the original number of colors (or 255) by typing in a 

number, using the left and right arrow keys, or by clicking and dragging the slider bar.
 To use more colors, move the slider to the right, use the right arrow key, or type a higher number in 
the box. To use fewer colors, move the slider to the left, use the left arrow key, or type a lower number 
in the box.

4 When the picture in the preview window at the right appears as desired, click OK.
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11Viewing Pictures and Designs
Use the View tab to set how you view the drawing, grid fade the picture, and measure 
aprts of your design.

Canvas 
Use the Canvas area to set the size of the Canvas.

Use Scale Image  to increase or decrease the size of the picture on the Canvas. See “Scale Image” on 
page 89.

Resize Canvas
Use Resize Canvas  to change the size of the 
Canvas for the Draw and Paint windows. 

Use the Width and Height settings for Canvas to 
set or change the size of the design area. Click OK 
to use the new settings.

If Scale up or down to fit is selected in Paint 
Image, the image in the paint tab will be rescaled 
to fit the new canvas.

If Keep original scale is selected in Paint Image, the Paint image may be cropped to fit the 
new canvas.

If Keep original scale is selected, a drawing created in the Draw window over an image in the Paint window 
may no longer fit over the image in the Paint window.

Width
Set the Canvas Width from 20mm to 1000mm. The initial size is 100mm.

Height
Set the Canvas Height from 20mm to 1000mm. The initial size is 100mm.

Paint Image

Scale up or down to fit
Add padding to the sides of the image so that the canvas matches the new proportions.

Show and adjust the grid Fade the background picture in the Paint tab

Measure an object or designSet the size of the Canvas
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The Paint image will remain the same quality, but any Draw objects drawn over it may no longer match.

Keep original scale
Maintain the scale of the Paint image in relation to the Draw objects. This will crop the 
Paint image when the size is reduced.

Any Draw objects drawn over the Paint image will retain the same proportions. The Paint image may be 
cropped, or become pixellated.

Grid
Use the Grid functions to set the position and size of the grid, and to show or hide it.

Show Grid
Use Show Grid  to turn the background grid on and off. The grid may be used to help 
align objects and points.

Turn the background grid on or off using Show Grid.

The grid size is measured in pixels of the background picture, so the apparent grid size will vary according 
to the dimensions of the picture.

Shortcuts
■ View Tab, Grid: 
■ Keys: Alt, V, SG

Grid Start
Choose a position for the start of numbering for the grid. Select Center or Top-Left from 
the drop-down menu. The initial Start position is Center.

Shortcut
■ Keys: Alt, V, GS

Grid Size
Choose the distance between the heavier grid lines.

The grid size is initially set to 5mm. Adjust its Size between 2 and 50mm, depending on 
what setting is most suitable for your screen resolution and design. Type in a figure and 
press ENTER (or use the up and down arrows to change the number). 

Shortcut
■ Keys: Alt, V, GR

Sub-divisions
Choose the distance between the pale grid lines.

Sub-divisions are initially set to 1/4. In the drop-down menu, choose from: None, 1/2, 1/3, 
1/4, 1/5, 1/6, 1/8, 1/10 or 1/16.

Shortcut
■ Keys: Alt, V, SU
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Background
Show, fade or hide the picture in the Paint window to use it as a background on which to 
create a drawing. 

View Background
Use the Background slider bar to show, fade or hide the background picture in the Canvas. 
Change the view of the background picture to make it easier to see the lines and fills for 
the design.

Get Length
Use Get Length  to measure the distance between any two 
points on the canvas. Click the Get Length icon  and the 
mouse pointer changes to the Measure pointer . Then click 
and drag a line across the design. The length of the line is 
displayed.

For example, use this to obtain the width of a design, or the 
distance between two sections.

The length is shown in millimeters or inches, according to the setting for Show Measurements in 
Preferences. The alternative units are shown in parentheses.

Shortcuts

■ View Tab: 
■ Keys: Alt, V, GL

Measure a Distance with Get Length
1 In the View tab, click the Get Length  icon. The pointer changes to the measure pointer .
2 Click and drag across the part of the design you want to measure. A line will show the length you are 

measuring, and a tooltip displays the distance.
If desired, make a note of the number.

3 Repeat the click and drag to measure any other distances, as required.
4 Right-click to deselect the function.

Use Background On  to show 
the picture in the background.

Use Fade  to show the picture 
in the background with the colors 

faded by 50%.

Use Background Off  to hide 
the picture. 
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Zoom Commands
A number of functions are available to make it easier to navigate around designs. These 
include the Zoom functions and the Overview Window. By default, each design is shown 
at a size so that the grid fills the window, the same as if you click Zoom To Canvas  after 
zooming in or out.

Shortcuts

Zoom To Rectangle
Use Zoom To Rectangle  to enlarge the view of an area of the design.

Click the Zoom To Rectangle icon  to the right of the status bar, and the mouse pointer 
changes to the zoom in pointer . Then either click a point on the design you want to 
zoom in towards, or click and drag a rectangle around the area you want to enlarge and 
release the mouse button to zoom.

Zoom To Rectangle is automatically deselected after you have used it.

Shortcuts

■ Status Bar: 
■ Keys: Ctrl + 0

If you have a wheel mouse, hold the Ctrl key and move the wheel to zoom.

Pan Mode
Use the Pan feature to move around the screen easily. The Pan feature works when you are 
Zoomed In on part of the screen, making the scroll bars visible at the right and bottom of 
the Canvas.

Hold the Space key down until the pan cursor  appears, then click and drag.

The pan occurs in real time, that is you see the canvas move as you drag across the screen.

Pan Around the Canvas
1 Click Zoom To Rectangle  and the arrow pointer changes to the zoom in pointer .
2 Click and drag to draw a box, then release to zoom in. Scroll bars appear to allow you to move around 

the screen at this higher zoom level.

Zoom Out Keys: Ctrl + -

Zoom To Rectangle Keys: Ctrl + 0

Zoom In Keys: Ctrl + =

Zoom To Canvas Keys: Ctrl + 9

Zoom to Selection Keys: Ctrl + 8

Click and drag to zoom in on an area

Zoom to Canvas
Drag to zoom in and out

Click to zoom in instantly
Click to zoom out instantly

Select or input percentage zoom
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3 Hold the Space key down, then start to click and drag. The pan cursor  appears.
4 Click and drag until the pointer is in the desired part of the screen. (If you have a wheel mouse, you 

can click the wheel to pan around the screen.)
5 Lift the pen or release the mouse button.

Zoom To Canvas
Use Zoom To Canvas  to view the whole work area. Click the Zoom To Canvas icon  
and the view will zoom in or out to show the Canvas in the window.

Shortcuts
■ Status Bar: 
■ Keys: Ctrl + 9

Zoom to Selection
Use Zoom to Selection  to zoom to the selected designs, or to all designs on the canvas. 
Click the Zoom to Selection icon  and the view will zoom in or out to show the selected 
designs, or all designs on the canvas.

Shortcuts
■ Status Bar: 
■ Keys: Ctrl + 8

Zoom by Percentage
Use the drop-down list in the Status Bar to set percentage levels to zoom in from 10% up 
to 800%. Alternatively, enter a number in the percentage text box.

Select 100% to display the design at a magnification as close as possible to the Real Size setting you chose 
in Preferences.

Zoom Bar
Use the Zoom Bar to zoom in or out from the center of the picture or design.

The Zoom Bar is on the right side of the Status Bar.

Use the slider to zoom in or out of the picture or design, or click on the Zoom Out  or 
Zoom In  icons.
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12Preferences
Use Preferences  to select the Surround color and Transparency pattern, and to choose 
whether to show the rulers around the Canvas, and use pressure sensitivity with graphics 
tablets. When these are changed, the new settings will be remembered when mySewnet™ 
Draw & Paint is closed and reopened.

Shortcut
■ File Menu: 

Colors
Change the color for the Canvas and Grid in mySewnet™ Configure.

Surround
The Surround color is the color used outside the grid boundaries. Set 
the Surround color for your mySewnet™ Draw & Paint software to 
whatever you prefer. Click on the down arrow next to the Color block 
and a palette appears of 40 colors. Move the pointer over the Color 
palette until the color you prefer is highlighted, then click again. 
Alternatively, select More Colors and the Colors window appears to 
allow you to choose any color from the 16 million colors of the 
Windows Color Matrix (see “Colors Dialog Box” on page 29). The color set by default is 210, 
210, 210 (RGB).

When you change the Surround Color the new color is immediately applied.

Set the Surround color

Show the Rulers around the canvas

Preview the Surround color

Use pressure sensitivity with graphics tablets

Choose the pattern for transparent areas

Use a relative position when cloning
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Transparency
Set the color and pattern indicating transparency for your 
mySewnet™ Draw & Paint software. Click on the down arrow next to 
the Color block and a menu of options appears. Choose a color from 
the menu.

Tools

Rulers
Hide or show the rulers around the left and top sides of the canvas.

Use Pressure Sensitivity
Use pressure sensitivity with graphics tablets.

Persistent Offset for Clone Tool
Change the default behavior for the origin pointer when using the Clone  tool. See 
“Clone” on page 84.

• The area copied moves with the pointer when this option is selected. This is the default 
setting.
This happens even when the mouse button is released, enabling you to copy multiple areas 
within a picture, and to clone recently cloned areas. 

• If Persistent Offset for Clone Tool is not selected, when the mouse button is released the 
origin point reverts to its original position. The same area is then copied each time 
Clone is used.
This is useful when copying the same motif repeatedly in different part of a picture.

Right-click and select Reset Origin from the context menu, or press the Ctrl key, to reset 
the origin point when cloning.
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13Troubleshooting

Error Messages
Acquiring and Loading Pictures

"Could not load picture file."
This message could appear if the desired picture is not where the module expects it to be, 
for example if it was loaded from a USB stick, then closed and the USB stick removed. It 
could also appear if the file you are attempting to load is corrupt. For example, it might 
have an extension such as .bmp or .jpg, yet not be a proper picture file.

"Error while inserting file. "Filename.svg" could not be inserted. The error 
"No usable vector graphics objects" occurred."
This message could appear if the vector graphics .svg file being opened contains no 
vector objects, for example, if it contains only a Bitmap graphic.

You may still be able to use the affected graphic if you open it in a graphics package which 
can handle .svg files with no vector objects (for example Inkscape), and then save the 
picture as a .png file.

Saving Files

"Error saving picture."
This message appears on attempting to save the picture and the picture is not saved. For 
example, if you attempt to overwrite an existing picture that is read only or if you attempt 
to save the picture to a read only location such as a CD-ROM.

Exporting Files

"Cannot export design."
This message appears if you try to use the Export function when there is no information to 
export.

"Cannot save file."
The program cannot save the file. Ensure that the disk where you are trying to save the 
design is not write-protected, then try again.

"You can’t save here. Please choose another location."
This message appears if, for instance, you have loaded a drawing from a CD-ROM and then 
attempt to save the embroidery back to the CD. A CD-ROM is read only, therefore you will 
not be able to save the embroidery.
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"Design File is read-only. Cannot continue."
This will happen if you attempt to open a design that has been set as read-only, or is read-
only because it is stored on a CD-ROM. If the design file is on your hard disk as read-only 
then you must change its properties in Windows® Explorer so that it is no longer read-only. 
For designs on CD-ROMs, use Windows® Explorer to copy them to your hard disk, then 
change the properties so that they are no longer read-only. (Windows® Explorer Help has 
information on the read-only attribute.)

"Filename already exists. Do you want to replace it?"
This happens when you are doing a Save As on the .ecq design file and you have given the 
name of a file that is already there. Click Yes or No as appropriate. You may have to replace 
a file several times if you are creating stitch files to stitch out tests of your design.

"Disk is write-protected. File not saved"
This will happen if you try to save a file to a floppy disk that has the write-protect tab open. 
Either take out the floppy disk and close the write-protect tab, or use a different floppy 
disk.

Choosing and Creating Motifs and Creating Machine Stitches

"Please choose a valid motif pattern."
This message appears if you try to select a motif from My Motifs, and all the motifs have 
been deleted from My Motifs. Use mySewnet™ Draw & Paint to add at least one motif to 
My Motifs.

"The start and end points do not line up. Add a stitch?"
This message may appear when exporting a drawing to My Motifs or as a Machine Stitch. 
Motifs and machine stitches are usually designed to stitch from left to right, and to start 
and finish at the same level. This function allows you to add a stitch to ensure the start and 
end points line up.

Miscellaneous

"Error. Not enough memory to perform operation."
This message will appear when system resources are low. Close other programs and try 
again. If this does not work, try restarting your computer.
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Other Topics
Screen Appearance

"Some of the icons in the Ribbon bar are 'grayed out'."
Certain icons (for example Cut on the Draw tab) are only highlighted once a design is 
shown on the screen. Also, when there is a design on the screen, some functions that 
might cause a mismatch between the size of the design and the size of the picture are not 
available in the Picture window.

"I have changed grid color and spacing and now I wish to return to the 
original settings."
Use Preferences to change the grid color. Follow the instructions in the Preferences 
section and select Mid Blue (RGB values 85, 150, 185) from the standard color drop-down 
on the Grid Color button.

Use the Size setting on the View tab to change the grid spacing. Set the Grid Size to 10.

"I have changed the screen background color and now I wish to return to 
the original light blue."
Use Preferences to change the background color. Follow the instructions in the 
Preferences section and select the RGB values 230, 245, 255 in the Colors dialog box.

Loading Pictures

"I loaded a small picture, and it has too many jagged lines."
Although the program automatically doubles the size of a picture if its height and width 
are less than 500 pixels, this may still produce jagged lines. For a smoother effect, rescan 
the picture.

Selecting Parts of a Design

"I did not select all the objects I wanted with Box, Point Line or Freehand 
Select."
Objects must be fully enclosed by the selection line to be selected as part of a block. If 
even the smallest part of an object is outside the line then it will not be selected.

Working on the Draw Tab

"Color Tolerance does not show me all the lines that will be traced by a 
Trace function."
The dashed line used by Color Tolerance only shows the outside of the area that is 
selected by the current Color Tolerance value. Simply try the Trace function and if the 
result is not satisfactory then Undo the result and retry the trace with a higher Color 
Tolerance.
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"I have selected Join, but I cannot join any objects."
Join can only join together open lines. Closed lines (shapes) cannot be Joined.

When Join is used, all open lines are indicated by a round handle. If no round handles are 
visible when Join is selected, there are no open lines.
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14Quick Reference Guide

Ribbon Tabs

File Tab/Menu
New Clear the screen ready to create or load a new design.

Ctrl + N

New Window Open an additional mySewnet™ Draw & Paint window.
Ctrl + Shift + N

Open Open an existing design, replacing the design on the screen.
Ctrl + O

Recent Open recently used designs.

Insert Insert an existing design into your current project.
Ctrl + I

From Scanner or 
Camera

Display the program that is used to acquire pictures from the selected device.

Save Save the design with the same name.
Ctrl + S

Save As Save the design under a new name.
Ctrl + Shift + S

Export Picture Export your picture in .SVG, .PNG or .JPG graphics format.

Preferences Set the stitch and screen options.

Configure Open mySewnet™ Configure.

Exit Close the current window and prompt to save new and changed designs.
Alt + F4
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Draw Tab
Clipboard Section

Select Section

Clipboard
Copy Copy the selected objects to the clipboard, without affecting the current 

selection.
Ctrl + C; Alt, D, CC

Paste Paste the objects on the clipboard back into the design.
Ctrl + V; Alt, D, CP

Cut Cut out the selected objects and place them on the clipboard.
Ctrl + X; Alt, D, CU

Duplicate Make a copy of the selected objects, which is automatically pasted on the 
Canvas below and to the right of the original.
Ctrl + D; Alt, D, CD

Delete Delete the selected object or the last object in the design.
Delete; Alt, D, CX

Select
Object Select Click on the object that you want to select. 

Alt, D, O

Box Select Select a block of objects by drawing a rectangle.
Alt, D, B

Freehand Select Select a block of objects by drawing a line around the required objects.
Alt, D, F

Point Line Select Select a block of objects by clicking a series of points to create an irregular 
outline of straight or curved lines around the required objects.
Alt, D, P

Select All Select all visible objects as a single block.
Ctrl + A; Alt, D, SA

Select None Deselect all of the objects in the work area, including any outside the grid.
Ctrl + Shift + A; Alt, D, SN

Replace 
Selection

Replace the currently selected objects with the new selection.
Alt, D, SR

Add To 
Selection

Add the new selection to the currently selected objects.
Alt, D, SD

Remove From 
Selection

Remove the new selection from the currently selected objects.
Alt, D, SN
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Combine Section

Group Section

Snap Section

Send Section

Combine
Make Holes Create a hole within the selected objects.

Alt, D, MH

Uncombine Break apart an object combined using Make Holes. Any holes in fill areas will 
be removed.
Alt, D, MU

Group
Group Group all selected objects together.

Ctrl + G; Alt, D, GG

Ungroup Separate the objects, or groups, within the selection.
Ctrl + U; Alt, D, GU

Ungroup All Split all the groups within the selected group into their individual objects.
Alt, D, GA

Snap
Snap to Grid Align objects to the Grid lines when drawn or moved.

Alt, D, NG

Snap to Line Snap to an existing drawn line when drawing.
Alt, D, NL

Send to Paint Send the selected vector objects in the Draw window to the Paint 
window as an area of pixels.
Alt, D, ST

Motifs and 
Stitches

Insert Motif
Open an existing motif to modify it.
Alt, D, MA, IM

Export to My Motifs
Save the design or selected area on the screen to the My Motifs 
database.
Alt, D, MA, ET
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Manage My Motifs
Delete unwanted My Motifs.
Alt, D, MA, M

Insert Machine Stitch
Open an existing stitch to modify it, or to export it as a motif.
Alt, D, MA, IS

Export as Machine Stitch
Save the drawing or selected area as an .spx machine stitch.
Alt, D, MA, EM
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Paint Tab
Clipboard Section

Select Section

Clipboard
Copy Copy the selected objects to the clipboard, without affecting the current 

selection.
Ctrl + C; Alt, P, CC

Paste Paste the objects on the clipboard back into the design.
Ctrl + V; Alt, P, CP

Cut Cut out the selected objects and place them on the clipboard.
Ctrl + X; Alt, P, CU

Duplicate Make a copy of the selected objects, which is automatically pasted on the 
Canvas below and to the right of the original.
Alt, P, CD

Delete Delete the selected object or the last object in the design.
Delete; Alt, P, CX

Select
Box Select Select a block of objects by drawing a rectangle.

Alt, P, B

Freehand Select Select a block of objects by drawing a line around the required objects.
Alt, P, F

Point Line Select Select a block of objects by clicking a series of points to create an irregular 
outline of straight or curved lines around the required objects.
Alt, P, P

Ellipse Select Select an area of the picture by drawing a circle or ellipse around it. 
Alt, P, E

Magic Wand Select an area of similar color to where you clicked.
Alt, P, M

Select All Select all visible objects as a single block.
Ctrl + A; Alt, P, SA

Select None Deselect all of the objects in the work area, including any outside the grid.
Ctrl + Shift + A; Alt, P, SN

Invert Selection All the currently selected areas become deselected, and the deselected areas 
become selected.
Alt, P, SV

Replace 
Selection

Replace the currently selected objects with the new selection.
Alt, P, SR

Add To 
Selection

Add the new selection to the currently selected objects.
Alt, P, SD

Remove From 
Selection

Remove the new selection from the currently selected objects.
Alt, P, SM
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Insert Tab 
Shape Section

Lettering Section

Design Section

Shapes Select a Shape from the gallery.
Alt, I, P

Insert Shape Add a shape to the drawing.
Alt, I, SS

Font Choose a font on your computer.
Alt, I, O

Style Choose a font Style.
Alt, I, W

Size Set the font size in points.
Alt, I, I

Alignment Align the lettering Left, Center or Right.

Left : Alt, I, AL

Center : Alt, I, AC

Right : Alt, I, AR

Insert Lettering Add text to your design.
Alt, I, L

Design Gallery Add a drawing from the Design Gallery.
Alt, I, M

Insert File Insert a drawing into your design.
Alt, I, F

Send to Paint Send the selected vector objects in the Draw window to the Paint 
window as an area of pixels.
Alt, I, ST
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Multiply Tab
Multiply Mode Section

Circle Options Section

Horizontal Options Section

Vertical Options Section

Enable Multiply Activate the Multiply options.
Alt, M, E

Apply Multiply Place the multiplied designs on the canvas.
Alt, M, A

Cancel Multiply Cancel the current Multiply.
Alt, M, N

Circle Multiply designs in a circle.
Alt, M, MC

Horizontal Multiply designs along a horizontal line. 
Alt, M, MR

Vertical Multiply designs along a vertical line.
Alt, M, MV

Tile Multiply designs within a horizontal and vertical grid.
Alt, M, MT

Repeats Set the number of repeats for the multiplied circle.
Alt, M, CR

Mirror Reflect the designs to form pairs.
Alt, M, CM

Alternative 
Mirror

Reflect the designs with a rotated axis.
Alt, M, CA

Repeats Set the number of repeats for the multiplied line.
Alt, M, RR

Size Set the width of the Multiply area.
Alt, M, RS

Mirror Reflect the designs to form pairs.
Alt, M, RM

Repeats Set the number of repeats for the multiplied line.
Alt, M, VR

Size Set the height of the Multiply area.
Alt, M, VS

Mirror Reflect the designs to form pairs.
Alt, M, VM
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View Tab
Canvas Section

Grid Section

Background Section

Length Section

Canvas

Resize Canvas Change the size of the Canvas for the Draw and Paint windows.
Alt, V, R

Grid
Grid Show or hide the background grid, and set its size.

Alt, V, SG

Grid Start The start position of the Grid, Center or Top-Left.
Alt, V, GS

Grid Size The Grid size.
Alt, V, GR

Sub-divisions Alt, V, SU

Background
Fade Use the slider to Hide, Fade or Show the Paint window image.

Get Length Measure the distance between any two points on the Canvas.
Alt, V, GL
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Help Tab 
Help Topics List help topics.

F1; Alt, H, H

About mySewnet™ 
Draw & Paint

Display program information, version number and copyright.
Alt, H, A
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FilmStrip
FilmStrip Items

Object
Each object is represented graphically. 

Object Type
The name of the object type is shown.

Object Name
The name of the object is shown.

Layout Order
Move Forwards Bring one step closer to the front of the design.

Move Backwards Bring one step closer to the back of the design.

Move to Front Place at the front of the design.

Move to Back Place at the back of the design.
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Draw Panel
Line Section

Fill Section

Draw Section

Points Section

Line Color Click to change the line color.

Pick Line Color Select a color from the picture and make it the line color.

Remove Line Color No line is placed around a fill.

Swap Colors Switch the line and fill colors.

Line Width Choose a width for your line.

Fill Color Click to change the fill color.

Pick Fill Color Select a color from the picture and make it the fill color.

Remove Fill Color No fill is placed within an area.

Point Draw Click points to create a line.

Freehand Draw Click and drag to draw a line.

Bezier Draw Use Bezier drawing to create a line.

Trace Line Trace the outline of a background picture to create a line drawing.

Trace Area Trace a background picture with no outline to create a filled drawing, 
or a line drawing.

Trace Area & Hole Trace an area of a background picture the includes a hole to create a 
filled drawing, or a line drawing.

Edit Points Use Edit Points to enable the moving and editing of an object’s points 
if another function is being used. 

Insert Points Add a new point to the currently selected line.

Delete Points Delete points from the currently selected line.

Knife Slice the selected objects along the line you draw.

Join Join two open lines together.

Convert Points 
to Curve

Change the selected point in a Bezier line to a Curve point.

Convert Points 
to Corner

Change the selected point in a Bezier line to a Corner point.
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Edit Section
Rotate 45 Rotate the selected block of objects by 45 degrees.

Transform Use the Transform dialog to show and change the size, rotation and 
skew of the currently selected block.

Center in Canvas Move the selected objects to the center of the Canvas.

Horizontal 
Alignment

Align Left
Align all selected objects on the left edge.

Align Center
Center align all selected objects horizontally.

Align Right
Align all selected objects on the right edge.

Distribute Horizontally
Align all selected objects to be equally spaced horizontally.

Vertical 
Alignment

Align Top
Align all selected objects on the top edge.

Align Middle
Center align all selected objects vertically.

Align Bottom
Align all selected objects on the bottom edge.

Distribute Vertically
Align all selected objects to be equally spaced vertically.

Convert to Point 
Line

Change the selected Bezier Line to a Point Line.

Convert to Bezier 
Line

Change the selected Point Line to a Bezier Line.
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Paint Panel
Mode

Tools

Color / Intensity

Brush

Tolerance

Soft Edges Use a soft edged tool for editing photos and paintings.

Hard Edges Use a hard edged tool for editing solid areas in clipart.

Paintbrush Paint lines on the picture that follow the movement of the pointer.

Line Draw straight lines in the picture.

Flood Fill Fill an area of the picture with the selected color.

Blur Blur the area under the brush.

Highlight Increase the lightness of an area of the picture, and make it more 
prominent.

Lowlight Decrease the lightness of an area of the picture, and make it less 
prominent.

Clone Copy a color and texture from one part of a picture to another.

Expander Increase the width of lines or areas in the picture.

Erase Remove areas of the picture with the Eraser.

Flood Erase Fill areas of the picture to make them transparent. 

Color Choose the colors for the picture.

Pick Color Select a color from the picture on the screen.

Intensity Change the intensity of the color in the brush or tool you are using.

Brush Shape Choose a Brush shape for painting with. 

Size Set the width of your brush stroke. 

Angle Set the angle of your brush.

Tolerance Adjust the number of shades of a color that are selected when using a 
tool such as Magic Wand or Flood Fill.
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Edit
Rotate 45 Rotate the selected block of objects by 45 degrees.

Remove Red-eye Reverse the red-eye effect caused when flash is reflected back 
by the retina of the eye.

Canvas

Scale Image
Increase or decrease the size of the whole picture on the 
Canvas.

Crop to Selection
Decrease the size of the picture by removing the parts that are 
not wanted.

Rotate Canvas
Rotate the whole picture by any degree. 

Perspective Correction
Remove the effects of perspective in a picture, or correct skew.

Expand to Match Canvas
Resize the contents of the Paint canvas so that it fits the width of 
the Draw Canvas by adding Transparent areas.

Fill Transparent
Fill any transparent areas of the canvas with the selected color.

Effects Change and enhance the picture.

Line Finder Enhance the picture with Line effects.
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Toolbars
Quick Access Toolbar

Status Bar
Use the Zoom Commands on the Status Bar to navigate around designs.

Insert Insert an existing design into your current project.
Ctrl + I; Alt, 1

Save Save the design with the same name.
Ctrl + S; Alt, 2

Save As Save the design under a new name.
Ctrl + Shift + S; Alt, 3

Undo Undo the last action.
Ctrl + Z; Alt, 7

Redo Redo the previously undone action.
Ctrl + Y; Alt, 8

Zoom To 
Rectangle

Increase magnification of an area of the design.
Ctrl + 0

Zoom To 
Canvas

Fit work area to screen.
Ctrl + 9

Zoom to 
Selection

Zoom to the selected designs.
Ctrl + 8

100%
Display picture at 100% magnification.
Ctrl + 1

200%
Display picture at 200% magnification.
Ctrl + 2

400%
Display picture at 400% magnification.
Ctrl + 3

800%
Display picture at 800% magnification.
Ctrl + 4

75%
Display at 75% magnification.
Ctrl + 5

50%
Display at 50% magnification.
Ctrl + 6
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25%
Display at 25% magnification.
Ctrl + 7

Zoom Out Decrease magnification.
Ctrl + -

Zoom In Increase magnification.
Ctrl + =
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Index
Numerics

16-bit High Color 10

24-bit or 32-bit True Color 10

45 Degree Rotate 88

A

About the Program 2

Acquire Picture 10

Acrobat Reader® 1
Add

Points 48

Add To Selection 20
Align

Bottom 55

Center 54

Left 54

Middle 55

Right 54

Top 55
Alignment

Horizontal 54

Tools 54

Vertical 55
All

Select 19

Ungroup 58

Alter Color in Color Box 27, 81
Angled

Line 32
Append

To a Line 46

Apply Multiply 71, 121
Area

Color 125, 127

Create 125, 127

Deselect 17

Edit 45

Get Length Of 106

Group 55

Select 14
Areas

Select and Resize 24

Auto-contrast 99

Autolevel 98

B

Background 106

Eraser 84

Flood Fill 84

Background Colors 109
Backup

MyMotifs 64
Backwards

Move 60
Bar

Ribbon 3

Scroll 59

Status 5

Title 3, 5

Zoom 108

Bezier Draw 32
Bezier Mode

Convert Points 49
Block

Cut 51

No Handles 15

Skew 53
Block of Objects

Delete 23

Horizontally Mirror 23

Mirror 22

Modify 21

Move 21

Nudge 21

Resize 21

Rotate 23

Select 14

Skew 22

Vertically Mirror 23

Blur 101

Picture 101

Bold 42

Bold Italic 42
Bottom

Align 55

Brightness 97

C

Camera 10
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Cancel Multiply 71, 121

Canvas 5, 104
Center

Align 54

Of Rotation 21, 23
Change

Line Color 31

Sequence of Objects 59

Size of Whole Picture 88
Choose

Drawing Colors 27, 80

New Drawing Color 29

Circle 72, 121

Draw 41

Circle Options 121
Clipart

Export as 11

Close the Program 2
Closed

Line 38
Color

16-bit 10

24-bit or 32-bit 10

Area 125, 127

Change Line 31

Choose New Drawing 29

Grid 110

Line or Fill 29

Models 29

Palette 27, 80

Panel 4

Pick 27, 81

Surround 109

Color Box 27, 80

Alter Color 27, 81

Color Filter 100

Colorize 100
Colors

Choose Drawing 27, 80

Dialog Box 29

Line and Fill 27
Connecting Parts of a Design

Motifs 66

Contrast 98

Convert Points 49

Convert Points to Corner 49

Convert Points to Curve 49

Convert to Bezier Line 50

Convert to Point Line 50

Copy 24

Objects 23

Picture 24
Create

Area 125, 127

Lettering 42

Pictures 26

Crop 90
Curved

Line 32
Curved Line

Reshaping 46

Cut 24

Block 51

Group 51

Line 51

Objects 23

Picture 24

D

Delete 23

Block of Objects 23

MyMotif 64

Points 47
Deselect

Selection 15

Wrong Area 17
Design

Choices 27

Connecting Motif Parts 66

Load with Drag and Drop 11

Pasting and Inserting 15

Design Gallery 43
Design Size

Motifs 65
Designs

Load 43

Open Recently Used 11

Save 11

View 104

Desktop Shortcuts 2

Despeckle 102

Digital Camera 10
Distribute

Horizontally 55
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Vertically 55
Double-headed Arrow

Colors 28

Drag and Drop to Load Design 11

Draw 26, 79

Circle 41

Freehand 31

Point 31

Shapes 41

Square 41

Draw a Circle in Bezier Mode 33

Draw a Flower using Bezier Curves 35

Draw Tab 37, 116, 119
Drawing

Insert 8
Drawing Color

Choose 27, 80

Choose New 29

Drawing Panel 4

Edit Area 45

Group Area 55

Select Area 14

Duplicate 24

E
Edit

Pictures 14, 45, 88

Points 45

Edit a Bezier Line 34
Edit Window

FilmStrip 124
Editing

Individual Lines 45

Tools 45
Effects

Image 96

Effects and Filters 96
Ellipse

Select 18
Ellipse Select

Remove Red Eye 89

Enable 71

Enable Multiply 71
Erase

Background 84

Eraser 84

Error Messages 111
Existing Line

Change Color 31

Exit 2

Expand to Match Canvas 91
Export

Clipart 11

Machine Stitch 69

To MyMotifs 63

Export Picture 12

Exporting Motifs 62

F
File

Formats 7

Name 8, 9, 68

File Menu 115

File Tab 115
Files

Picture 7

Files of Type 8, 10, 68
Fill

Change Properties 30

Flood 82

Properties 30
Fill Color

Pick 28

FilmStrip 58, 124

Items 58, 124

Open Group 59

Select Object 59
Filter

Color 100, 101

Filters 93

Filters and Effects 96
Find

Outlines 95

Finding Information 1

First Visible Object 60

Flood Fill 82

Background 84

Font 42

Formats of Files 7
Forward Movement

Motifs 66
Forwards

Move 60
Freehand

Draw 31

Select 16
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Freehand Point
Select 17

G
Gallery Designs

Group 56
Gamma

Picture 98

Get Length 106

Getting Started 1
Grayness

Color Effects 99

Grayscale 99, 100

Grid 105

Snap to 38, 106

Grid Color 110

Group 56

Area 55

Cut 51

Open in FilmStrip 59

Grouping Selected Objects 55

H
Handle

Rotation 23

Round 23

Square 21

Trapezoidal 22

Triangular 22
Heading 2

Brush Types 86
Heading 3h

Fill Transparent 92

Help 1

Help Tab 123

High Color (16-bit) 10

Highlight 83

Horizontal 72, 121

Alignment 54

Horizontal Options 121
Horizontally

Distribute 55

Mirror Block 23

Hue 99
Hue Saturation Luminance (HSL)

Color Model 29

I

Image Effects 96
Import

Machine Stitch 68

Motif 62

Inches 106
Information

Finding 1
Insert

Designs 15

Drawing 8

Insert File 44

Insert Points 48

Insert Tab 41
Intensity

Color Filter 100, 101

Inverse Color Filter 101

Invert Selection 19

Italic 42

J

Join 46

Lines 38

K

Knife Tool 51

L

Layout Order 60, 124
Lead-in and Lead-out Lines

Motifs 66
Left

Align 54
Length

Of Area 106
Lettering

Create 42
Lightness

Picture 83

Line 45, 82

Angled Section 32

Appending to 46

Change Color 31

Change Properties 30

Closed 38

Curved 32

Cut 51

Edit 45

Properties 30

Smoothness 31, 46

Smoothness Options 31

Snap to 38, 46
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Straight 32

Line and Fill Colors 27

Line Color 27

None 28

Line or Fill Color 29
Lines

Joining 38

Lead-in and Lead-out 66

Lining Up the Motif 66

Load Design with Drag and Drop 11

Look In 8, 10, 68

Lowlight 83

M
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